FuseGl - “Cooperation for fusing skills on Cloud-based

Open Geolnformatics: Innovative Environmental
Management”

104

Training toolkit
Final Version 30/07/2022

AGREEMENT NUMBER: 2019-1-FR01-KA203-062767
Coordinator: UNIVERSITE D'AVIGNON

Leading Organisation of |04: DIMOKREITIO PANEPISTIMIO THRAKIS (DPT)




INTELLECTUAL OUTPUT 4 FINAL REPORT CREATION

Activity Responsible Organisation
Document Dr.Dionissis Latinopoulos, Maria DPT
writing Koulouri
. Dr.Christos Akratos, Dr. Fotios Maris DPT
Review
Dr. Georgia Galidaki OLYMPOS

Acceptance

Dr. Konstantinos Chalikakis

AVIGNON UNIVERSITY




TABLE OF CONTENTS

1

2

3

5

SUMMARY .ttt sttt et b e s bt st st s bttt e bt e s be e sbeesaee et e e b e e nheesaeesaeenane 1

ABBREVIATIONS. ...ttt ettt sttt et ettt e st st et e bt e b e e sbeesmeeeneeeneens 2

INEFOAUCTION ..ttt sttt et e b e s b e st e st e b e ebeenees 3
1.1 Overall objectives, implemented activities and results of the FuseGlI Project.......... 3
1.2 Interrelations of project Intellectual QULPULS .......cocccvviiiiciiieiiiieeccee e 4
1.3 Scope and Objectives of Intellectual OULPUL 4........ooeevieiiiiiiee e 4
1.4 Structure of Intellectual QULPUL 4 .........oviiiiiieee et 5
1.5 Intellectual Qutput 4 SUD tasks .....coccuiiiiiiiiieicie e 5

Methodological @PPrOACK ....ciieiiii e 6
2.1 [T o T 1 o] VA o] o T 1Y PP 6
2.2 Creation of courses, case studies and testing .......cceeecveeeeeciiiee e e 7
2.3 REVISING The tOOIKIt......eiiieiiiee it e e e e e e e eaaaeee s 8

T COUPSES ..ttt ettt ettt ettt ettt ettt et e sttt e s bt e s bt e e sabeesbeesbteesabeeesbbeesaseesabeeesabeenanes 8
3.1 Course 1: INtrodUCHION. .....cieiiiiiiie ettt et s 9
3.2 Course 2: SPatial DAta ....cccccuveeieeiiie e e et ae e e nres 15
33 Course 3: Introduction to QGIS SOftWare........cccevveeieiiieiienieeeeeeeeee e 20
3.4 Course 4: Georeferencing, Scanning and Editing ToOIS.........ccccccvvveeeicieeeecciiee e, 28
3.5 Course 5: Spatial ANalYsiS......ceiieiiiiiiiiiie e e 37
3.6 Course 6: CartOgraphy .. ... ciie i 44
3.7 CoUrSE 7: Grass GIS......eiiiiiieei e 52
3.8 Course 8: Hydrological Analysis and QGIS TOOIS ......cccueeeeeciiiieiciiieecceee e, 59
3.9 Course 9: Web Scraping Applications in QGIS........cccccveviievieieiciiee e 65

THE CASE STUIES ...eeieiriiiiieie ettt ettt st en e esnees 74
4.1 LULC/FOREST CASE STUAY w.euveuveneenieiieiieieeteriestesie ettt sae st nne s 74
4.2 HEAIth CaSe STUY.......vieiieiiiee ettt e e e e e e e et e e e e e nteee e ennes 81
4.3 Case StUdY 1 in HYdrolOoZY .....cceeeviieeiiiee ettt et 84
4.4 Case Study 2 in HYdrolOogY .....coeeevieieiiiee ettt e e 89

Innovation, Tangibility and Transferability........ccccceeeiieieeiiiiicc e 93



SUMMARY

AVIGNON UNIVERSITE, in cooperation with DEMOCRITUS UNIVERSITY OF THRACE, EE4S,
INSTITUTE OF INFORMATION AND COMMUNICATION TECHNOLOGIES, MAISON REGIONALE
DE L’ EAU, INTERNATIONAL HELLENIC UNIVERSITY and HELLENIC FORESTS (OLYMPQS PC), has
undertaken the implementation of the project entitled “FuseGI — Cooperation for fusing skills
on Cloud-based Open Geolnformatics: Innovative Environmental management” under the
Agreement n° 2019-1-FR01-KA203-062767 with Agence Erasmus + France, within the “2019
Round 1 KA2 - Cooperation for innovation and the exchange of good practices KA203 -
Strategic Partnerships for higher education” Call.

More precisely, this intellectual output aims to address all call priorities described in the
Application Form, meaning: Open education and innovative practices in a digital era
(Horizontal) by creating a set of free novel courses in a public platform including hands on
training and self-evaluation techniques, Tackling skills gaps and mismatches (HE) since it
follows the assessment of market needs (I01) and educational gaps (102) covering an
important part of the draft curricula, and Supporting individuals in acquiring and developing
basic skills and key competences (Horizontal) since it actually provides an environment for this
though 9 courses and 4 specialized practical case studies that were created responding in
actual market tasks.

This report presents the design and implementation of Intellectual Output 4 “Training toolkit”
highlighting the innovative means adopted in methodological approach to create tangible and
transferable results in the Geographic Information (Gl) field.

This 10 aims to deliver a pilot training program, covering basic theory required for geospatial
data in order to introduce students to the practical part, freeware (software) training,
providing extra (free) training material, tests, self-evaluation, course and project evaluation
forms, including also hands on practice, podcasts and practical case studies among others. The
training toolkit was formed trying to reach a variety of people, of different academic levels
and fields.

The 104 builds upon the findings of 101 using field review to locate the gap between the actual
and desired market skills, 102 assessing the gap in GIS education in the participating countries
and setting a draft curricula, and 103 researching the available cloud-based platforms, VLE
applicability and opportunities for building interactive novel courses, with complementarity
and not overlapping.

The findings from the course creation, the course and platform testing and evaluation, of 104
on diverse subfields of the environmental sciences were used as input data in the core of 105
with the ability to upgrade and expand them.
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ABBREVIATIONS

Gl Geoinformatics

GIS Geographic Information Systems

10 Intellectual Output

VLE Virtual Learning Environment

ICT Information communication Technology
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1 Introduction

1.1 Overall objectives, implemented activities and results of the FuseGlI Project

The FuseGl consortium had identified a gap between what the academic world provides
towards its teachings and what the environmental labor market requires in terms of Geographic
Information Systems (GIS) skills. Skills that are nevertheless essential for environmental and
health risks management.

The goal of this consortium was to conduct an in-depth study (qualitative and quantitative) on
the subject and then to design, develop and make available an adapted online tool to fill this
GIS skills shortage to students and young professionals for the needs of the labor market.
The FuseGI consortium is composed of experts in the fields of water management, forestry and
health (from both the academic world and the private sector) as well as computer scientists
capable of setting up and sustaining online training tools. It was therefore relevant from the
perspective of the project. ERASMUS+ through the projects "Cooperation in innovation and
exchange of best practices" was the ideal and most relevant framework to achieve a project in
this direction.

The overall objectives of the FuseGl project were:

1. Establishment of a transnational, interdisciplinary and open collaboration between
academia and industry within the EU to address the training needs in GIS for better
functionality and better environmental and health risks management.

2. Knowledge transfer and bridging of gaps in academic and professional experience of
the partners in the use of GIS applications in different key environmental and health
sectors.

3. Improved professional skills in the use of open GIS platforms for interdisciplinary
collaborative data processing.

4. Development, implementation and validation of a virtual learning environment (VLE).
Design of the architecture of an adapted curriculum, corresponding to the needs of the

market world, for master's degree courses.

Five transferable, innovative and tangible outputs:

I01: Research and field review
I02: Draft Curricula

I03: Learning platform

104: Training toolkit

IO5: Final Curricula
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1.2 Interrelations of project Intellectual Outputs

The concept and the methodological approach of the FuseGl project allowed strong
interactions between all intellectual outputs. Each intellectual output represent an innovative,
transferable and tangible result also as a necessary step for the project finalisation.

The following scheme (Fig. 1) represent the interrelations and connectivity of the FuseGl
intellectual outputs.

Draft
Curricula
VLE
platform
Research and field
review
Training toolkit
Final
Curricula

Figure 1 : Scheme of interrelations of FuseGl intellectual outputs

The 104 builds upon the findings of 101 using field review to locate the gap between the actual
and desired market skills though GIS systems and curricula revision, questionnaires. It also
incorporates 102 assessing the gap in GIS education in the participating countries and setting
draft curricula, lectures and courses. 104 and 103 co-development and creation provided the
basis through researching the available cloud-based platforms, VLE applicability and
opportunities for building interactive novel courses. All 10s are really important standalone
procedures, necessary to map gaps, needs, tools and methods, in a market with advancing
needs as they owed in a study-based project, and all are fused with complementarity and not
overlapping points

1.3 Scope and Objectives of Intellectual Output 4

The scope of this Output is a multiple one since it actually creates a solid tool to be adopted
by institutions, enterprises and individuals willing to learn or deepen their knowledge on GIS.
FuseGl within this project wills to develop a program toolkit in order to present the program
features, methodology, contents and delivery mechanisms.

The toolkit was designed to assist the user to articulate a clear understanding of the context
of FuseGl and actively engage themselves to learning process and accomplish courses as well
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as enhance the operational capacity of FuseGl project to deliver successful Gl and
Environmental Management knowledge.

All training material/ references are uploaded at the project’s platform and will be updated.
Training coordinators, curriculum developers, and trainers can all use the Toolkit in preparing
and presenting Gl and Environmental Management training as was stated in the AF.

Though, through the solid findings of the previous |I0s and the partnership’s will to create
something timeless as a basis for further development this toolkit was even developed to a
complete set of courses, able to be included even in graduate and master programmes with
an equivalence of 7 ECTS. What’s more, the entire tool is based on freeware (QGIS) supporting
openness in its entity using explicitly creative commons rights, open data, open courses and
free books and manuals in the PowerPoints and in the supplementary material and operating
through an open VLE platform.

The consortium’s effort surpassed the foreseen working man-days but created more than a
platform, but a self-tutoring tool for scholars and businesses, free from rights, easy and
accessible.

1.4 Structure of Intellectual Output 4

The content of this report is organized as shown below.

1%t section describes introductory elements for the 104

2" section delineates the methodological approach adopted for the 104 production
3" section details on each course separately

4t section details on each case study

5t section highlights the importance of the findings delineating innovation, tangibility and
transferability

1.5 Intellectual Output 4 Sub tasks

Sub task

Strategic design to apply the FuseGl vision using open software

Consulting professionals on teaching methods and desired outcomes for building a curriculum

Revise existing available training and teaching material

Definition of access criteria, the participants profile, entry requirements and selection process

Setting courses’ and case studies’ criteria (format, duration, rights, training, testing, evaluation)

Testing VLE platforms compatibility and extensions

Determination of Desired Cognitive skills and course thematic structuring

Creation of the courses (ppts, podcasts, accompanying documents, training material, tests and
evaluation forms)

Selection and formatting of real-life practical case studies
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Testing of toolkit within the platform

Launching the training toolkit

Review period (internal and external)

Launching the revised final version of the toolkit

2 Methodological approach

In order to effectively train the users of the platform, 9 online courses are available on the
platform as well as 4 case studies to put into practice the theoretical explanations.

The FuseGl VLE platform currently offers 9 courses to bridge the gap between the knowledge
of graduating students and the expectations of professionals for the job. Classes may
sometimes contain small exercises to help understand the lesson. In addition, a case study is
available to implement all the functionalities of GIS and more particularly QGis.

The structure of each course is very similar: we first find an introduction, then a plan defining
the different parts of the development, the development in question and then a conclusion
and the associated sources. In addition, the language used for the courses is English, as it is
universal, it facilitates access to all European users.

2.1 Preparatory phase

After having conceived the Strategic design how to apply the FuseGl vision and how to
conform with the AF stating “The tool kit will be organized in several major units. Each unit
will be made up of modules which themselves will contain smaller units covering an important
component and learning objectives of Gl and Environmental Management” we selected using
open GIS software and the optimal selection was QGIS based on the availability of a range of
add-ons and the compatibility with other software.

Given the recent covid period and the “activation” of distance learning techniques, we
consulted professionals on teaching methods and desired outcomes for building a curriculum
based on the 102.

Then we revised the existing available training and teaching material from institution open
courses, data providers, QGIS tutorials and tips, and existing exercises in order not to overlap
with already accessible material (but to use it as supportive providing links and databases)

In close collaboration with the VLE platform, we defined the access criteria, the inclusivity (e.g.
for people with impaired vision), the broad range of participants profile, entry requirements
and selection process adopting the idea that the theory that is taught and the information
given must be understood by both a graduate of an engineering school and philosophy.

The next step was setting courses’ and case studies’ criteria (format, duration, rights, training,
testing, evaluation). So, for each course, we selected to provide a course summary, the
cognitive skills, a podcast for the course presentation, the basic PowerPoint presentation,
keywords, sources and literature used, a folder with additional data supplementary material
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(links, books, databases, exercises), create a short quiz (mostly for self-assessment reasons,
not for grading) with multiple takes ability and both a course and project evaluation form.

Then we tested the selected open VLE platform Moodle for compatibility with embedded
video and document players safeguarding also inclusion policy.

2.2 Creation of courses, case studies and testing

Based on the Outcomes of 102 and 103 and the recognized range of gaps both in market skills
and Geolnformatics education we deemed that a set of 9 courses, 3 of them introductory and
6 practical (including also QGIS addons like GRASS) as described in the pictures below (Fig. 2,
3).

" «GIs history 2 spatial Data + Setting up QGIS s
« Applications & * Plugins “ « Spatial Analysis Tools
CRF z S
Uses. ,  Nature of data : OosiBats * Geometric * Basic Statistics
* Spatial Questions + Descriptive P © = X Correction « Buffer Zones
* GIS Software Attributes sSaving / Printing * Georeference * Intersect/Union/Clip

- « Layers * Digitization -
1 GIS Introduction o Vector vs Raster « Editor S Spatial Analysis
Models * Symbology
* Comparison
\ W . \ &
1. Nature of spatial data (2/2) i"‘ 2. Georeference process (4/8) .\..*w

. » -
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Figure 2. Lessons 1 to 5 flow chart with basic context presentation.

o ¢ Hydrol
+principles & A invoducton m
Target of

Chartography * Toolboxes « Applications
* Map Layout * GRASS GIS *DEM of GISin
s Ks| * Flow Direction Public Health
* Symbols & workspace
6 Maps & ¢ Image Processing
Canog?aphy * Main commands yais
3. Map Lyout (2/5) @.“

Figure 3. Lessons 6 to 9 flow chart with basic context presentation.
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As the case study selection, we came in contact with experts and professionals in the fields of
water, forests and health to meet their most usual tasks and needs through these case studies.
Then we had to find the primary-raw data and select the proper articulation for describing the
problem at hand and the solution we seek. Then we chose to “assist” the students by providing
them optionally with a series of sub-tasks, as steps for the case study completion and where
they could find each QGIS command to perform each action.

Then, before the official launch of the toolkit, we tested it with experts and then with students
from participating universities (master and graduate) both individually and during C2 and C3
joint training event. Corrections were made according to indications.

2.3 Revising the toolkit

The first version was completed in time according to the Application Form. The final teaching
material included in 104 was produced by co-shaping the 105 final Fuse Gl curricula. This
approach was selected in order to endorse the results from the validation phases that were
held during the program, meaning the first edition of the platform tested by the consortium,
focus groups, students and dissemination events as described in the Application Form. These
gave important feedback that allowed us to evolve and adapt the material. These findings
could be concluded in:

Augmented need for extra hands-on practice.

So, the second version of the toolkit had a clear aim: to ensure the competency-based
approach promoted by 105 finalized so as to fully master the newly acquired knowledge on
QGIS tools and techniques.

The actual revised version of the toolkit had some adjustments for every level of the
Finalcurricula design according to the competency-based approach.

Discovery level: The introductory courses were increased from 2 to 3 courses to distribute
(equalize) the teaching duration and break it into more easily assimilable lectures.

Getting started level: There was the need for even more supplementary material related to
the training for further self-engagement. The courses already included databases and practice
exercises but in the final version, these were doubled in number.

Advanced use level: The revised version of the toolkit, trying to cope with the range of skills
of the involved “students” of the program decided to raise the difficulty in two real-life case
studies, naming Forestry and Hydrology ones along with the addition of Hydrology 2 case
study related with biodiversity.

This series of adjustments in the first version advanced the training material (structure and
content) and increased the overall quality of the toolkit ensuring competency-based approach
which is the goal of 105.

3 The courses

In order to effectively train the users of the platform, 9 online courses are available on the
platform as well as 4 case studies to put into practice the theoretical explanations.

The FuseGl VLE platform currently offers 9 courses to bridge the gap between the knowledge
of graduating students and the expectations of professionals for the job. Classes may
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sometimes contain small exercises to help understand the lesson. In addition, a case study is
available to implement all the functionalities of GIS and more particularly QGis.

The structure of each course is very similar: we first find an introduction, then a plan defining
the different parts of the development, the development in question and then a conclusion
and the associated sources. In addition, the language used for the courses is English, as it is
universal, it facilitates access to all European users.

3.1 Course 1: Introduction

The first course introduces the basic concepts of GIS, but also the definitions. We also find
key figures and the history of GIS. We also learn more about the possible applications of GIS
and its uses in certain areas. These courses allows to anyone know the types of questions that
can be solved thanks to GIS and it also highlights the different software that can be used to
make GIS. This course also illustrates the advantages and disadvantages of using GIS (Figure

4).
N
Contents »_-w*)
Erasmus+

1. Definition and basic concepts

2. The history of geographical information systems
3. GIS Applications & Uses

4. Questions GIS can answer

5. GIS Software

6. Benefits & Advantages

FuseGl advancing GIS professional skills

Figure 4 : Slideshow map of course 1, available via the FuseGl VLE platform.

The first part of this course defines the basic concepts of GIS, as well as the different reasons
for using them to improve communication between different scientists (Figure 5).
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1. Definition and basic concepts

g U i
\ Erasmus+

* For several reasons, it is difficult to give a proper definition of Geographical Information Systems.

* GIS include both manual and computer-based information systems. The most common and acceptable definition could
be the following:

A geographical information system is a system that can capture, store or create, manage,
analyze and map all types of data.

D Geographical
& related supporting
- data elements

« Different kind of data is connected to a map providing useful information in order to improve communication through
scientists as well as better management and decision making.

* GIS uses data that is attached to a unique location and perform a number of management and analysis functions.

FuseGl advancing GIS professional skills 6

Figure 5 : Slide 6 of course 1, available through the FuseGl VLE platform.

The courses are quite simple to understand, a maximum of figures are added to the text to
facilitate the understanding of it (Figure 6). For example, in order to explain the history of GIS,
it is possible to use a timeline.

2. The history of Geographical Information Systems (1/2) \—\:* e

Between 1854-1960 there was limited
development in GIS while mapping was paper
based. In 1960s computers started
developing. Michael Goodchild’s research on
spatial analysis and visualization brought
revolution in the world of geographic science.

Howard Fisher created one of the first
computer mapping software programs
known as SYMAP.

1960 1965

® ® () ®
1963 1969

Roger Tomlinson created the first GIS in the
world for the Canadian government.
Tomlinson designed an automated system in

Two members of the Harvard team founded
Environmental Systems Researchers Institute
(ESRI).The ESRI' s team developed many of

the GIS mapping and spatial analysis methods
that are used even today.

order to store large amounts of data
concerning Canadian natural resources.

FuseGl advancing GIS professional skills 7

Figure 6 : Slide 7 of course 1, available via the FuseGl VLE platform.

The second part of this module traces the history and improvements of GIS over time, from
its inception in 1960 to the present day (Figure 7).
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2. The history of Geographical Information Systems (2/2) ;—:“ e

The progress in computer technology led to
the creation of commercial GIS Software.
ESRI” s work won recognition while ARC/INFO-
the first commercial GIS products were
developed. Today, GIS and spatial analysis are used by
everyone. Thousand of people and
1981 Today organizations are sharing their work,
creating any kind of maps and use GIS in
® & () management decisions. GIS provides real
time information and is essential in a
2000 variety of sciences, such as chartography,
geography, engineering and natural
Open source GIS was born. Data and images resources management.
coming from Landsat satellite are accessible
to everyone. GIS is online, in the cloud and
on mobiles.

FuseGl advancing GIS professional skills

Figure 7 : Slide 8 of course 1, available via the FuseGl VLE platform.

The third part lists all the fields that can use GIS (Figure 5-2), such as tourism, geology, health
or politics.

3. GIS Applications & Uses (1/4 —
PP ( / ) S Erasmus+
GIS: a multidimensional scientific field
* Engineering Real * Environment
Estate * Agriculture
* Telecommunications* Architecture
* Tourism * Health
= Education * History
* Land Use Planning + Surveying/Geodesy
* Energy * Transmission
* Astronomy + Transportation
* Forestry * Hydrology
* Geology * Business
g * Archaeology * Climate Change
Pl + Geostatics * Ecology
- - g 5 Z * Ocean/Marine * Politics
20 Maraguras + Utilities * Weather
https://gisgeography.com/gis-appli
FuseGl advancing GIS professional skills 9

Figure 8 : Slide 9 of course 1, available via the FuseGl VLE platform.

This part also shows the possible use of GIS in different fields such as climate change, ecology,
hydrology or forestry (Figure 9).
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3. GIS Applications & Uses (2/4)

Climate
Change

Sea Level Rise

Collecting data on sea level rise
from different regions of the planet.
All of this data can be processed
and presented through GIS
applications. The purpose of this

Understanding the causes of
desertification such as
inappropriate agriculture
practices and drought. Areas
affected by drought or high

Studying how land surface
temperature changes year by
year. Through GIS, researchers
can extract fluctuating maps
with a combination of data and

research is to find the most rainfall are recorded in order to  study temperature changes in

vulnerable coastal areas and help decision makers in proper order to implement the most

construct the appropriate management of water resources  appropriate policy.

protection projects. and construction of hydraulic

projects.
FuseGl advancing GIS professional skills 10
3. GIS Applications & Uses (3/4) —
Erasmus+
Ve i %

Ecology

T

ke

Computing landscape metrics
and fragmentation over time
in areas burdened by human
factor. GIS tools can give

~ Honeybees
9

Analyzing relationships

Using GPS tools for

igl y bird locations
in order to reduce aircraft
strikes and also protect

GIS maps can study either the
decrease in biodiversity or the
abundance of species and help
make the right decision in

characteristics and honey
bee health. In the regions

where bees are healthy and  rare species from harmful important data about the order to protect species
people take care of them, human actions. changes that urban fabric has  biodiversity.
flowering  and  better brought to natural landscape.
ecological condition of the
plants are observed.
FuseGl advancing GIS professional skills 11

3. GIS Applications & Uses (4/4)

ki,
Erasmus+

Hydrology

Flow Direction
& Estimation

Flow
Accumulation

By introducing the right
contour lines in GIS,
researchers can create 3D
elevation models and estimate

‘ Forestry flow direction.
i /,L
{ / 4 Forest
{§3 20 NS Carbon
(1) i \¢ Reserves
Spread of wildfire in time can be presented using
the 3D virtual workspace of Capaware.
FuseGl advancing GIS professional skills 12

Figure 9 : Slides 10, 12 and 13 of course 1, available via the FuseGl VLE platform.

The fourth part provides a better understanding of the use of GIS. Indeed, this part explains
what types of problems can be solved using GIS, such as defining a forest area sensitive to
climate change (Figure 10).
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4. Questions GIS can answer (1/3) —\-:* -

* GIS enables to visualize information in ways that can reveal important relationships and trends.

* It can give answers to a variety of questions and spatial problems through the processing of both spatial and attribute
data.

* Users of GIS can answer geographic queries and analysis and make better decisions by creating better solutions.
*  GIS can identify spatial relationships between different map features.

* What is at..? This is the first and main question that GIS can answer by giving a variety of information concerning a
specific geographical area. A GIS map can combine different kind of data for a particular area e.g. place name, streets,
buildings or even trend of population. Users have access to both quantitative and qualitative characteristics of the
geographical area under study.

*  Where is what..? This could be the second most important function of GIS combining spatial information. Instead of
identifying locations, it can also find places where special conditions are satisfied. Users can find places that meet
specific requirements. This GIS feature might be the most important in decision making.

FuseGl advancing GIS professional skills 13

4. Questions GIS can answer (2/3) PUSQI L

* A GIS map can combine different layers of data. Landscape-hydrography-natural
characteristics-buildings-roads and land uses. That is why GIS can be applied to almost
any profession and science.

* Researchers can be interested in finding water bodies close to industrial areas.
Hydrologists can capture water flow and suggest new hydraulic projects. Ecologists can
search and study natura areas close to residential areas or study the increasing or
decreasing trends of flora and fauna in each area. Foresters can find, study or create
buffer zones around vulnerable areas to fires. Engineers can study population growth
and design new projects.

* The integrated management of water resources, coastal areas, natura areas and the organization and planning of
cities requires the use of GIS.

* What has changed..? GIS can show land use changes over time providing useful information and results for
landscape fragmentation.

FuseGl advancing GIS professional skills 14

4. Questions GIS can answer (3/3) @ S

* Understanding the need to manage environmental issues, European Union has developed the Copernicus program in
cooperation with the European Space Agency (ESA). The idea firstly developed under the name Global Monitoring for
Environmental Security (GMES), which was later renamed Copernicus.

« The aim of the program is to achieve a global, continuous and high quality observation of the Earth in order to provide
accurate and in-time information to improve environmental management, understand the effects of climate change
and ensure security policy.

* The program was established by
the regulation 377/2014 [2] in
April 2014. The platform was
designed in a way that it can
gather all the information about
the environment and monitor
land uses. Decision makers can
export any time the picture of
earth’s “health”.

opernicu

FuseGl advancing GIS professional skills 15

Figure 10 : Slides 13, 14, 15 of course 1, available via the FuseGl VLE platform.

In the fifth part, users of the platform become aware of all types of software using GIS,
whether paid software, such as ArcGIS, or the QGIS suite of free and open-source software
(Figure 11).
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5. GIS Software (1/2) :i o

hers and P of any size in industries like healthcare, marketing, construction, management and more
can use GIS and its capabilities to take their business one step further.

*  GIS software can be stored into different categories: open source software & commercial or proprietary GIS software.

* Open source GIS are based on three main groups in terms of prog ing | T

guages, Java and .NET.

* A project started in 1982 by the United States Army but is now open source, known as Quantum GIS (QGIS) is the most
popular ‘C’ based open source GIS software,

« Java offers geospatial functions like union or buffer and allows comparison between objects. Open Map and Geotools
are among the most known open source GIS using Java tools.

* Inthe GIS soft market, companies with the highest share are the following: 0 esri
» ESRI-ArcMap, ArcGIS
7 Autodesk-AutoCAD including Map 3D
» ERDAS IMAGINE-Erdas Apollo, Leica Photogrammetry Suite QAUTODESK
» Intergraph-GeoMedia

WNTeRGRAPH  “serdas

FuneGl adhvancirg GiS peofenional stib

5. GIS Software (2/2) @ -

* The first open source system appeared in 1978, GRASS GIS is the earliest open source GIS supported both raster and
vector data and was originally developed by the United States Army Corps of Engineers.

. n source GIS software available are the following:
% aes - v, QGIS
» GRASS GIS A
» Integrated Land and Water Information System (ILWIS) W °
7 uDig GRASS U D i g
» SAGAGIS

* Other GIS open services: Google Earth Pro, Google Maps.

* Other GIS open tools: Cap - 3D simulation of the progress of a forest fire. Kalypso software - offers
rainfall/rainoff simulation and flood mapping tools.

*  With a quick web research, prospective users can search reviews for every available software considering the
following criteria: editing, imagery, analysis and cartography tools,
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Figure 11 : Slides 16 and 17 of course 1, available via the FuseGl VLE platform.

The sixth and final part of this first GIS course is a list of advantages and benefits of using GIS
in the different areas listed above (Figure 12).

6. Benefits & Advantages @
Erasmus+

* The advantages of using GIS can be described in five main categories:

1. Improving the 8 and decisi king process.

GIS can manage not only spatial data and maps but also data from several sources in order to create digital maps and
give answers to geospatial questions. It is a helpful and necessary tool in policy making.

2. Cost reducing due to greater efficiency.
Costs in human resources and labor are reduced due to the increasing efficiency of new technological tools. Complex
analyzes are performed in less time.

3. Better storage and manage of geographic information.

GIS has considerable tools in data collection and analysis. Processing different layers of data at the same time.

4. Improving ication and cooperation b org:

Companies and individuals can share any kind of data and results. Researchers around the world can share their work
and exchange data and information.

5. Improving the quality of research and professional oppor
GIS technologies increase employment opportunities.

FuseGl advancing GIS professional skills 18

Figure 12 : Slide 18 of course 1, available via the FuseGl VLE platform.
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This first course teaches the basics of GIS as well as when to use GIS to process information
and communicate with other scientists and professionals

3.2 Course 2: Spatial Data

The second course defines raster and vector models. These concepts are very important for
using GIS. It also includes criteria for selecting raster and vector models and a comparison
between the two models. This course also introduces the concepts of layers and objects,
descriptive attributes, the nature of spatial data, and spatial data models (Figure 13).

Contents ,——W
Erasmus+

1. Nature of spatial data

2. Descriptive attributes

3. Layers and objects

4. Spatial data models

5. Vector and raster models / Selection criteria

6. Comparison

FuseGl advancing GIS professional skills

Figure 13 : Course outline 2, available via the FuseGl VLE platform.

First, the course defines the concepts of data collection as well as the characteristics of spatial
or geographical data (Figure 14).

1. Nature of spatial data (1/2) ‘Mwm> T

* Data collection is the most time consuming and costly process in GIS projects but also the most important one for the
study area. Geospatial data collection may include 1) field data collection or 2) remote sensing data processing.

* Data collected by remote sensing techniques is the main source of data in GIS projects. Data collected by aerial
activities and aerial photos are the basis for the creation of qualitive land-use maps. This kind of data provides useful
information in environmental studies and natural resources management.

*  GIS can convert real-world information into editable data format for further analysis and processing.

« Through field data collection users can also examine the attribute information associated with the area of interest. A
site visit, observation and interviews are important steps to the success of the field research.

* Spatial or geographical data are characterized by:
» position (geometry),
» non-spatial features (descriptive attributes) and
» the relationships between them.

* Geospatial data describe objects or features with a certain location on earth combining attribute information (the
characteristics of the object or other phenomena concerned).

FuseGl advancing GIS professional skills 6

Figure 14 : Slide 6 of course 2, available via the FuseGl VLE platform.

Next, the course develops the three geographical features that can be connected with
geometric elements: points corresponding to an object with a precise location, lines that can
represent linear elements such as a river, and polygons representing specific areas (Figure
15).
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1. Nature of spatial data (2/2) @ —

* Spatial data may refer to 2-dimensional or 3-dimensional space. All geographic features correspond to three basic
geographic entities related to their geometry: points, lines and polygons.

Wind turbine location Riverbed Agriculture field

S

* Each object associated with a unique location is described by a point (e.g. cities or monuments). Lines usually describe
elements that grow linearly (e.g. roads, rivers, borders). Polygons cover a specific enclosed area (e.g. lakes,
municipalities, land uses).

FuseGl advancing GIS professional skills 7

Figure 15 : Slide 7 of course 2, available via the FuseGl VLE platform.

Slide 8 allows platform users to better understand attributes and their usefulness in a GIS
project (Figure 16).

2. Descriptive attributes w
Erasmus+|

* Spatial data contain more information than only a location on the surface of the Earth. Any additional information that
describes a feature is referred as an attribute.

* Each geographical entity may have more than one descriptive attribute.
* For example, contouring maps include points where every point can give a non-spatial information, that of the
altitude. A map displaying buildings of a region not only give the coordinates of their location but may also have

additional attributes such as the type of use or the number of floors it has.

* Users enter manually the descriptive attributes of the objects they digitize. The information given can be displayed on
the desktop in the form of tables, known as attribute table.

* Attributes can be numbers (e.g. the students of a school. School can be rendered as a digitized polygon on a map.) or
text (e.g. school’s name).

* Entering the proper entities’ attributes is one of the basic processes of data collection, data organization and data
transfer to the environment of GIS coming from the field.

FuseGl advancing GIS professional skills 8

Figure 16 : Slide 8 of course 2, available via the FuseGl VLE platform.

This course is widely used to define the basics for beginners or to make reminders to more
experienced users, with for example the slide "Layers and objects (1/2)" which defines what
a layer is (Figure 17).
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3. Layers and objects (1/2) D

Erasmus+
» A.layers
* The traditional method of mapping the geographical space occupied by spatial data is a series of layers. The first space

modeling method developed is known as layer based approach and is still used today.
* Layers are defined based on:

» Geographical phenomenon, Roads
» Geometry (contains data of geographic entities: points, lines or polygons) and Land uses
» Descriptive attributes.
Boundaries
+ Examples of thematic layers: hydrological network, buildings, road network or Hydrography
ground cover. Depending on map’s purpose layers alternate and vary. Elevation
Aerial photo

« Layers analysis determines the degree of the model’ s completeness (how many?)
and depends on the purpose (which?).

GIS
—_—

From reality To a map
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Figure 17 : Slide 9 of course 2, available via the FuseGl VLE platform.

Like the previous slide, this one is intended to define another concept that is very important
for the use of GIS, the notion of object. It therefore defines objects and helps to understand
their uses (Figure 18).

3. Layers and objects (2/2) —\-:a e o

» B.Objects

* The space consists of distinct objects (object oriented approach). Each of them competes as a distinct object and there
is always a gap between them. For example, a model of reality of the electricity supply network consists of the objects
below: cables, columns and power stations.

* Object oriented approach aims to improve the quality of system analysis and make it more usable. It refers to a
programming language or software methodology that is built based on logical objects.

* An object exists within problem domain and can be identified by data (attribute) or behavior. Between them there are
relationships under processing and examination.

« The following processes are performed on the objects analysis:
» Construction/De-construction, creating new parameters of a class or deleting existing ones.
» Update, changing values to an object’s attribute.
» Query, finding answers without changing any attributes.

= Each group of similar types of objects belongs to a certain layer. Combining layers displays the reality through mapping.

FuseGl advancing GIS professional skills

Figure 18 : Slide 10 of course 2, available via the FuseGl VLE platform.

Then, the course again defines very important concepts to understand such as the difference
between a raster model and a raster model. In addition, it defines and informs on the
particularities of each of these types of models (Figure 19).
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5. Vector and raster models (1/6) iy T

* Geographic information systems and spatial databases use spatial models for the digitalization of geographic data. The
main spatial models at the conceptual level are:
» The vector models and
» The raster/grid or tesseral models.

« The conceptual spatial model must then be adequately described so that it is
practically possible to register its elements in a computer environment. Vector

model
» A. Vector models

* There are three main types of vector data: points, lines and polygons. Vector data

could be assumed as the graphical representation of the world’ s surface. 4]
Connecting points create lines and connecting lines create polygons. =
Raster } L\ H
* Vector data are usually stored in a file format known as shapefiles (.shp). model ti

« Vector points are a latitude and longitude or simply XY coordinates. Every point
has a unique location.

FuseGl advancing GIS professional skills 11

5. Vector and raster models (2/6) W Einaat

* Line is the basic logical unit expressed by a series of vertices with x,y coordinates. Points can be expressed as lines of
zero length. Polygons are expressed by the set of lines enclosing them.

= Vector models are suitable for digitizing discrete entities or phenomena.

(X3Y3) o (x3¥3) @ (X3,Y3) °

(x1y1) (x1y1) (x1,v1)/
.

(x2,y2) \(XZ,V/ \'/
. o (x2y2)

« Descriptive attributes of the entities of the vector

models are given through the attribute table.

Id Type Status Length

i & 4
Reality through /\,/ 1 National road Open 56.7 km
vector models \_'Z’/ o
2 Provincial 9.6 km

3 road S

e 3 | DirtTrall | Closed | 21km
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5. Vector and raster models (3/6) -\-:* —

» A. Raster/Grid models

= On the other hand, raster data are presented through grid of pixels that each one has a value. This kind of data comes
from photos taken from satellites or other aerial activities.

= In raster models geographical space is divided into cells of regular shape. Each cell constitutes the basic logical unit. All
cells together form a grid.

y :H
Size
of cell I

lake

agriculture

road

ECENE

residential

X
* The content of each cell corresponds to the value of a continuous variable. Raster models are suitable to describe
continuous phenomena. They are used for satellite images, scanned maps, Digital Terrestrial Model (DTM),
temperature maps etc.

FuseGl advancing GIS professional skills 13

Figure 19 : Slides 11, 12, 13 of course 2, available via the FuseGl VLE platform.

The course also helps to understand the geometric difference between vector and raster type
representations of points, lines and polygons (Figure 20).
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5. Vector and raster models (4/6) @

. AE

point line polygon

* Points are displayed as individual discrete cells. Lines as cells chains (rivers) and polygons as adjacent cells that form a
specific area (lakes).

g, B

Raster Vector Raster Vector
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Figure 20 : Slide 14 of course 2, available via the FuseGl VLE platform.

Thanks to this course, it will be possible for users of the platform to choose the appropriate
type of model based on the data they want to analyze (Figure 21).

5. Vector and raster models / Selection criteria (5/6) W o

* Choosing the appropriate spatial model is a crucial decision. The representation of spatial data affects the format and
the quality of the analysis.

= Modern GIS serve both categories of models and effectively contributes to the co-processing and co-utilization of data
(both vector and raster) relating to the same area.

* Spatial data selection criteria:
» Completeness, the degree of reality’s representation by each model.
» Durability, refers to the possibility by which a spatial model can handle special cases, such as when one polygon
encloses another polygon (topology).
» Ease of transformation of spatial data in the desired format.
» Ability of saving memory in the computer system.

* The ability of saving memory can be measured, so a quantitative comparison can be made between spatial models. On
the other hand, completeness and durability are qualitive criteria.

* The main difference between vector and raster models: Vector models are used to describe discrete entities while
raster models describe continuous variables.

FuseGl advancing GIS professional skills 15

Figure 21 : Slide 15 of course 2, available via the FuseGl VLE platform.

Then, the course makes the connection between the type of data and the format used in GIS
software like QGIS. For example, Shapefile files are used in vector format while GeoTiff files
are used in raster format (Figure 22).

Page |19



5. Vector and raster models / Data formats (6/6) \MW T,

* Most popular data format of vector and raster models used in GIS:
» Vector

DXF, Drawing eXchange Format, developed by Autodesk,

Shapefile, developed by Esri,

GML, Geography Markup Language, XML template for recording OGC geospatial data,
WKT, Well known text, text markup language,

GeoJSON, template used by open source GIS software,

KML, Keyhole Markup Language, XML OGC template for recording cartographic symbolism.

“ s e e e

» Raster

GeoTiff, TIFF file containing georeferencing data,

IMG, georeferenced images developed for ERDAS IMAGINE.
Esri grid, georeferenced raster data developed by Esri.
Binary File.

. e e .
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Figure 22 : Slide 16 of course 2, available via the FuseGl VLE platform.

Finally, this course concludes with a comparison of the two types of model by listing the
advantages and disadvantages of each (Figure 23).

6. Comparison i__..mm)
Erasmus+

* Both models have advantages and disadvantages regarding:
The need for storage space,

v

» The fidelity of displaying the location and attributes of real world’s spatial data,
» The ability of changing the efficiency scale and
» The possibilities of analytical processing.
* Vector models * Raster models
» Advantages » Advantages
* Ability to fully describe topological relationships, » Simple data structures,
* Direct definition of surfaces, * Ease of combining layers,
* High level cartographic performance,
* Ability to enter descriptive attributes and » Disadvantages
* Ease of updating the database. » Requirement for large memory space, that is no longer
problem.
» Disadvantages * Problems arise when the performance scale requires
* Complex data structures and better analysis than the raster model already has.

High processing requirements in multi-layer
combination case.
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Figure 23 : Slide 17 of course 2, available via the FuseGl VLE platform.

3.3 Course 3: Introduction to QGIS Software

The third course introduces QGIS software. This software is free and open access. The course
consists of an introduction to QGIS software. Part of this course explains how to download
the latest version of this software to users' personal computers, as well as the steps to install
the software. The rest of the course presents the different menu bars of the software, but
also how to install the extensions in it. In addition, this course provides an understanding of
the use of different coordinate systems, open data, but also how to add data and create
layers. It also helps us to properly save files and export the different projects (Figure 24).
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Contents ..:*
Erasmus+

. About QGIS

. Setting up QGIS

. Running QGIS

. Plugins

. Coordinate Reference System
. Open Data

. Layer Properties

00 N o U b W N P

. Saving / Printing
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Figure 24 : Course outline 3, available via the FuseGl VLE platform.

First, the course begins with an introduction defining the QGIS software suite (Figure 25).

1. About QGIS W
Erasmus+

* Quantum GIS known as QGIS is an open source Geographic Information System developed under the GNU General
Public License. This license allows the source code to be modifies and gives users the assurance that they will always

have access to a free GIS software.
QGIS

* It started in May 2002 and was officially established by the Source Forge community June of the same year. The
project’s purpose was the development of a free GIS software for anyone who has access to a personal computer. It is
also supported by the Open Source Geospatial Foundation (OSGeo).

* QGIS can be installed on many operating systems (Windows, Android, Mac OSX, Linux, Unix), supporting a variety of
formats and functionalities for managing and processing spatial data.

* In addition to the basic functions, its users have created a plugin repository with aiming the constantly expanding its
capabilities for everyone.

* QGIS has a friendly work environment and integrates tools and functions in order to manage, storage and analyze
spatial vector or raster data. It allows Coordinate System transformations, spatial analysis, geoprocessing of data and

publication on the internet. Editing capabilities are expanded with GRASS and other tool libraries.

FuseGl advancing GIS professional skills 6

Figure 25 : Slide 6 of course 3, available through the FuseGl VLE platform.

In this course is explained the path to follow in order to successfully install QGIS (Figure 26).
It is important to know that this software is downloaded with other GIS software, such as
GRASS GIS and SAGA.
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2. Setting up QGIS (1/2) W Erasmus+

» Installation _

* Users can download and install the appropriate version

of QGIS from http://www.qgis.org/.

Select the
appropriate
operating
system.

* New versions of QGIS are usually released every few e
months but it’s not necessary to upgrade the version e
you are already using. Users are constantly adding new
features as everyone can modify the open source code.
It is possible to have installed and run more than one
versions at the same time.

« |Installing QGIS is very simple. The latest version of
QGIS can be downloaded from http://download
.qgis.org/.

Select the latest ‘Q
version (more il
older releases are Q@
also available).

FuseGl advancing GIS professional skills 7

Figure 26 : Slide 7 of course 3, available through the FuseGl VLE platform.

The third course is useful for learning the features of QGIS software for beginners and also
serves as a reminder for more experienced users. Indeed, the menu bar is detailed to help the
use of the software (Figure 27).

3. Running QGIS (1/3) \M:m Erasmus+

* The initial environment may be different for each user depending the language and toolbars displayed. There are five
areas that can be distinguished: Menu, Toolbox, Layers, Map Area and Status Bar.

1. Main menu bar

(Q Untitled Project — QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

Project |s used to open, save, defining properties and printing Vector Contains tools in order to manage vector data
of a project
Edit |s used to edit data of a layer, add, correct, delete, etc Raster Contains tools in order to manage raster data
View Contains tools for navigating within a map, defining the Database Contains tools in order to manage databases
design area, etc.
Layer Is used to manage layers, creating or deleting ones Processing Contains additional tools for managing vector and
raster data

Settings Manages the characteristics of each project (options),
symbolism, etc. Help ' Leads to various helpful links
Plugins Manages additional tools

FuseGl advancing GIS professional skills 9

Figure 27 : Slide 9 of course 3, available through the FuseGl VLE platform.

This third course also describes the working environment of the QGIS software, such as the
toolbar, the location of the list of layers created or added, the visualization area of the map
as well as the status bar where we find the scale or the type of coordinates used for the project
(Figure 28).

Page |22



3. Running QGIS (2/3)

2. Toolbox: Tools can be displayed or hidden by View>Toolbars.

i 5 il
\ Erasmus+

e

"

~

3. Layers: The checkbox next to
each layer is used to show or hide it.
Layers series determines their design
order. There are several tools for
managing layers, such as grouping.

FuseGl advancing GIS professional skills

4. Map Area: In this area users can

manage the result of layers editing and
spatial processing. t 4~

5. Status Bar: The status bar

displays the Coordinates of the

/ cursor position on the screen as it

moves, the scale of the map and the
Projection System used.

10

Figure 28 : Slide 10 of course 3, available through the FuseGl VLE platform.

As QGIS software is open-source software, it is possible to add extensions (plugins) in order
to extend the functionality of the software. This course shows users how to install extensions

in QGIS (Figure 29).

4. Plugins

* QGIS developers and other independent users
create new plugin tools in order to extend the
functionalities of the software. Updates may need
due to new tools.

* Basic packet of plugins (Core Plugins) is part of the

initial installation of QGIS,
Street View

Street View

External plugins are available in the QGIS Plugins
Repository and must be installed using the Plugin
Manager Tool.

96 rating vote(s),

.

Installing new plugins (e.g. Street View, Google
Maps) consists of four steps.

Tags
More info

Author Saccon Fabio
Avaitable version (stable)

* Useful Tip: Settings>Options>General check the box
check QGIS version at start up. That informs users
for the latest updates.
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g O bt
\ ErasmusH

340717 downloads

updated at My ef 27 03:59:31
2020
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Figure 29 : Slide 11 of course 3, available via the FuseGl VLE platform.

Another essential point for the proper use of QGIS software is the reference coordinate
system used for the project. Indeed, it must be adapted to the area studied and is specific to

it. First, the course defines what a reference coordinate system is (Figure 30).
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5. Coordinate Reference System (1/2) W S

* To accurately determine the position of an object must be known:
» The geographical coordinates (A,$) and
» The cartesian coordinates (x, y).

« Cartographic projection is a way to represent parts of the surface of the Earth on a flat map. Each point of the Earth’s
surface is ambiguously connected to its counterpart on the map.

................ A
no) — v 5

Xa
X
* Due to deformations every time the reference surface is transformed (sphere or ellipse) into a plane, it is not possible
to faithfully represent all the geometric relations that exist in it.
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Figure 30 : Slide 12 of course 3, available via the FuseGl VLE platform.

Then, it shows the path to follow in order to define the coordinate system for each of the
layers of the project (Figure 31).

5. Coordinate Reference System (2/2) @ i

= Choosing the right Coordinate System is one of the first steps a user must take and depends on the data source to be
processed and the area in which it is located.

(e T —

+ Through the path below Menu>Project>Properties>CRS
users define the right Coordinate System.

* Geographic Information Systems have developed mainly
to analyze spatial data. Georeferencing satellite images or
digitizing objects are among the main functions require
proper Coordinate Systems to be defined.

« Sometimes layers and data coming from different regions
and source may be referenced to different systems and
that is why the right transformations must be done.

* Another way: click on the Coordinate System given in the
Status Bar.
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Figure 31 : Slide 13 of course 3, available via the FuseGl VLE platform.

Open data is data that is freely accessible, reusable and redistributable by everyone. These
data may be provided by public or private sources. In the sixth part of the third course, open
data is defined and some sites where it is possible to download data for free are cited (Figure
32).
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6. Open Data (1/4) ﬂ ——

* Organizations that publish standards for geographic information play a specific role in promoting interoperability. For
example:
7 International Organization for Standardization (ISO): creates international standards, e.g. ISO/TC 211.

ISO 19115:2003 has been revised by ISO 19115-1:2014 concerning Geographic Information — Metadata. 1SO 19115
defines the sch quired for describing geographic information and services. It provides information about the
identification, the extent, the quality, the spatial and temporal scheme, spatial reference and distribution of digital
geographic data ( hitps: //www.lso.org/standard/26020.html ).

Though I1SO 19115 is applicable to digital data, its principles can be ded to many other AT

forms of geographic data such as maps, charts and textual documents as well as Iso

non-geographic data. o4

» Europ Ci for Standardization (CEN): covers European interoperability issues, e.g. TC 287 Geographic
Information.

» Open Geospatial Consortium (OGC): develops standards for geographic data, e.g. Simple feature, GML, KML.

* The European directive INSPIRE (2007/2/EC) is responsible for geospatial i | infrastructure and other
activities that have an impact on the environment.
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6. Open Data (2/4) t’i Erasmus+|

* Geospatial data may be available from other sources:
» In different model types (raster or vector models),
7 As files in a wide range of managed formats (shapefiles),
» From online sources,
7 As a result of a voluntary geographic information collection initiative (VGI-Vol d Geographic Information).

* Users and researchers can also find data through open sources. "Open data” can be used free of charge or with
restrictive terms of ownership.

*  Web sites offered geospatial data are the following:
7 Global Self-consistent Hierarchical High-Resolution Shoreline (GSHHS),
7 Natural Earth: public domain chartography data hitp //wwwnaturalearthdata com  (scales used: 1:10.000.000,
1:50.000.000, 1:110.000.000),

» European Environment Agency http//www eea turope su/,
» Advanced Spaceborne Thermal Emission and Reflection Radiometer (ASTER),
7 Esri Open Data Hub https.//hub.aregls com/search,
» USGS Earth Expl https rthexplorer.usgs gov/,
» Open Street Map hitps.//ww nstreetmap org/#map=7/38.359/23 810,
7 Geotopo30 hitps.//ita.cru 5TOPO30.
FuseGl advancing GIS professionsd skits 15

Figure 32 : Slides 14 and 15 of course 3, available via the FuseGl VLE platform.

Next, the course shows how to integrate the downloaded data into the QGIS software
(Figure 33).

6. Open Data / input (3/4) w Erasmus+

* Geospatial data may be available in different model types (raster or vector models).

* Data in QGIS are added as separate layers. Images (can be scanned maps or results of aerial activities) are entered as
raster data, shapefiles as vector data.

* In QGIS: Main Tool Bar>Layer>Add Layer. ————————————
Add vector layer: ‘

.dxf, shapefiles,
kml.

[ P SR P ——.
W b e e == e

!5,
i

f

i

]

| §

i
]

Browse button

~ images, .jpg or
tiff files.
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Figure 33 : Slide 16 of course 3, available via the FuseGl VLE platform.

This course also allows you to understand and use the browser and layer panels available in
QGIS (Figure 34).

6. Open Data / input (4/3) “:“ Erasmus+]

* Also, select both browser and layers panels. View>Panels>Browser & Layers.

5 i Sae Q@ Untited Project — Q@S

Propa fdt ¥
L]

Lyer Settings Pluges Vectgr Bester

So you can have the
browser panel directly
accessible in the main
workspace.

Open the layer Styling panel Filter legend by map content
Add group EI Expand/Collapse all
EI Manage map themes Remove layer/group
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Figure 34 : Slide 17 of course 3, available via the FuseGl VLE platform.

This third course is also useful for learning the basics of using QGIS, such as creating layers,
whether for drawing lines, points, or polygons (Figure 35).
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7. Create layers (1/2) \* Erasmus

* In a GIS project geospatial data are rep d through different kind of layers. Layers may be found and studies as
open data In various web sources or can be created by users.

* In order to create layers: Main tool bar>Layer>Create Layer. Most common layer forms used are shapefiles. Clicking on

3
e 4
- !

* layers created by the following steps do not - - e

contain any information. Users should digitize the

reported elements. The digitization process will be

represented in the next lesson.

6
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7. Create layers (2/2) ﬂ Erasmus4

- ! Layer names always given
in Latin characters. The
| storage path s also
selected.

Choose the appropriate
| coordinate system
referring the study area.

A —_— et i Below, the information of the
e = i - elements that the shapefile will
fom contain is  given. This
Shapefiles may be points ik 5 s PP information is entered by the
(hospitals, museums etc.), lines —— /_,.—/ =2 o user and displayed through the
(roads, rivers, etc.) or polygons ) - attribute tables.
(lakes, a_rus o f interest), Th' o~ ‘"""“‘"‘f’:‘:'sm 08 fiscsdoas’ [ sd
appropriate  geometry s 6

Fosd length | numbes

selected depending to the
elements to be digitized.
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Figure 35 : Slides 18 and 19 of course 3, available via the FuseGl VLE platform.

Finally, the last slide of this third course shows how to save and save the project (Figure 36).

8. Saving / Printing @ Erasmus+

* Save your progress: Main menu>Project>Save as. QGIS projects are saved as .qgz files and contains all the images, layers
and elements of your present work for future processing. The extension for QGIS projects is .qgs but when saving from
QGIS, the default is to save using a compressed format with the .qgz extension. The .qgs file is embedded in the .qgz file.
Use Latin characters for the file names and avoid spaces.

Q@ “Urnted Projct — Qs

BER] 1% ter iow g Bges Vectgr Boter Qe

Q "Uratied Prjet — G5
£ Yoo Liye Gemngs Bugms Vg Bete Qeibue Wb Meh Srogesing
PR > A [

en o

* Through QGIS you can export your maps to
images or .pdf or .dxf file formats.
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Figure 36 : Slide 20 of course 3, available via the FuseGl VLE platform.
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3.4 Course 4: Georeferencing, Scanning and Editing Tools

This fourth course allows to continue deepen the mastery of QGIS software. Indeed, we can
find in it the different steps to follow to carry out the georeferencing process, the creation of
layers or those of correcting the geometry of a layer (Figure 37).

Contents r—
Erasmus+

. Geometric Correction
. Georeference process
. Creating layers

. Digitization

. Editor/ Attributes

. Symbology

N oo b WN e

. Practice

FuseGl advancing GIS professional skills

Figure 37 : Course outline 4, available via the FuseGl VLE platform.

After learning in the previous course how to create layers, it is important to know the editing
tools, georeferencing as well as scanning. This is why the course begins by defining the
usefulness and purpose of the geometric correction of photographic data made in QGIS
(Figure 38).
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1. Geometric Correction (1/2) ﬂ Eraamuss

*  GIS projects use satellite images and aerial photos for a wide range of applications. These photos are used as base
maps for urban planning purposes and for agricultural monitoring. This kind of analysis requires that the location of
features in the image are accurately determined planimetrically (X,Y) and elevationally (2).

* The position of each feature should be represent its true and exact Jocation
on the earth's surface.

| The above image is » historicsl
S serid photo when by o
miltary akcraft. in ordes 10 be
wsed a3 2 base in 2 GIS project
noeds to be comrected.

* Geometric correction Is the process of correcting satellite images or aerial
photos from their displacements and ensures that pixels/features in the Images
are in their proper and exact position,

= Through geometric correction spatial distortions in the original image are eliminated or minimized and the output

dimensions correspond to a chosen geographic reference system,

FuseGl advancing (IS profenions! shils 6

1. Geometric Correction (2/2) @ —_——

» Satellite images and aerial photos contain a number of geometric distortions due to the data recording procedure and
the shape and rotation of the Earth.

* Erdas Imagine is of the most well-known software, providing tools for remote sensing and photogrammetry. Erdas
Imagine simplifies iImage classification and segmentation, orthorectification and image interpretation and It is widely
used in geometric correction. QGIS can also be used to geometrically correct images.

* One way to geometrically correct the original image is to collect a set of Ground Control Points (GCPs). These points
are locations that can precisely identified both on remotely sensed imagery and in the target geographic reference
system, Coordinates of GCPs can be obtained either by a GPS survey on the ground or by identifying GCP locations on

funel advancing G protesvonal skt 7

Figure 38 : Slides 6 and 7 of course 4, available via the FuseGl VLE platform.

The georeferencing process is an indispensable process for adding photographs to GIS
projects (Figure 39).

2. Georeference process (1/8) @ Erasmus+

* Main sources of geometric distortion:
» Sensor characteristics, optical distortion and non-linear mirror velocity.
» Motions of the drone/aircraft or satellite, earth rotation and altitude changes.
» Viewing geometry, panoramic effect and earth curvature.

* Correcting the distortions is often costly and time consuming. On the other hand georeferencing is the process of
recording the absolute location of data while georectification refers to the removal of geometric distortions.

* The process of Georeference is completed by selecting pixels in the digital image and assigning them geographic
coordinates. It is a fundamental process to geospatial technologies in general.

= By definition, geographic information systems need location accuracy. Georeference may be applied to any kind of
object that can be related to a geographical location, such as points of interest, roads or buildings.

* Historical images may contain essential information. Through Georeference historical images can be compared with
that currently available. It can be used to analyze the changes in a study area over time.

* To Georeference an image, you should firstly establish control points with known geographic coordinates and then
choose the right coordinate systems and projection parameters.

FuseGl advancing GIS professional skills 8

Figure 39 : Slide 8 of course 4, available through the FuseGl VLE platform.
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This process uses files in GeoPDF or GeoTiff formats, the tool used to perform georeferencing
is already included in QGIS (Figure 40).

2. Georeference process (2/8) @ Erasmus+

Control  points
with known
coordinates (x,y).

* GeoPDF and GeoTiff are examples of georeferenced file formats.

* Georeferencing images in their right position allows basic map analysis to be done, to calculate distances and areas
and determine any other spatial information.

FeseGl achancing GIS peofessionad skily 9
2. Georeference process (3/8) \-—:a
Erasmus+
* Georeferencing is already part of QGIS installation. Main R ferencer. Then a sep dow opens,

which Is divided Into two sections.

* The top section where
the images are displaying.

* The bottom section
where the control points
will appear.

£

The process of
File>Open Roster. Next, the user must click on GCPs and enter their coordinates manually and choose the
transformation settings by Settings>Transformation Settings. Finally, File>Start Georeferencing. The georeferenced
image is automatically displayed in the main QGIS workspace.

e actually Ives four basic steps. The images (or scanned maps) are firstly imported by

Fusei advancing 615 professional siols 10

Figure 40 : Slides 9 and 10 of course 4, available via the FuseGl VLE platform.

Then, instructions on how to use the "georeferencing" tool are given in the slides
"Georeference process 4/8" and "Georeference process 5/8". The first case of georeferencing
a photograph is when a map and known coordinates are used. It is important to choose the
type of transformation algorithm to georeference the image (Figure 41).
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2. Georeference process (4/8) T‘i Erasmus+

1. Georeference a map with GCPs of known coordinates.

* To get started go to the Menu Bar>File>Open Raster and import the image of interest from your browser. This could be a scanned map,
an aerlal photo or a cropped image from any software using geospatial information.

* The image displays on the top section of the window, Make sure the 7 Add Point button is selected.

* (Click on a point to create the first reference point and enter the cor di di ily. Click OK and they will appear in
the bottom table. You can add as many reference points as you like but it is not recommended.

' When dealing with a flat-surface
image, 2 to 3 reference points
should be sufficient. Reference
areas near the edges of the image
are often preferred.

| By ciicking on a point
| of known coordinates,
this window opens
automatically in order - B Sy A
10 add known XY, ST T T

Control Points Table

Fusels! advancing GIS profassional skl 11

2. Georeference process (5/8) ‘\-'i Ersoites

* After you have added the Ground Control Points to the raster image, you should define the transformation settings for the
georeferencing process,

« The choice of trans hm ks dependent on the type and quality of input dsta and the
N noumber of geometric distortion that you are willing to introduce to the final result.

*  The Lineor algorithm does not sctually transform the raster pixels and it & used to create a world file. At
least 2 GCPs are needed. The Helmert transformation allows rotation and it Is useful f your raster is
good quality local map or an orthorectified aerial image. At least 2 GCPs are needed. The Polynomial 1

& s used to geore data cartograms and at least 3 GCPs are required. The Polynomial 2.3

algodthms need at least 6 GCPs. The Proje igorithm requires a of 4 GCPs and i1 is used

georek g angled ph The Thin Plate Spline is most useful for georeferencing
damaged, deformed or othorwise slightly inaccurate maps or poorly orthorectifiod aerial photos

*  QGIS allows five different resampling methods. Choosing the Nearest Neighbor does not change
statistics of the raster

*  As defoult & new output raster will be created in the same folder of the original image with the
extension _modified.

* 1 you wish to continue working with this image click the last option 5o to load the georeferenced image
in the main QGIS workspace.

FuseGl advancing GIS professional siolis 12

Figure 41 : Slides 11 and 12 of course 4, available via the FuseGl VLE platform.

In case the coordinates of the photo to be georeferenced are known from Google Earth, the
process is a little different (Figure 42).

2. Georeference process (7/8) i e

2. Georeference an aerial photo using known coordinates from open software Google Earth.

* An another way to georeference an image in QGIS uses Google Earth software. Google Earth is a geospatial analysis
platform that enables analyzation to satellite images of the planet and is available for free.

* Google Earth tools allow you to save points with known coordinates according to the World Geodetic System (WGS84).

The steps to be followed do not
change. Coordinates should be
entered carefully as longitude
and  latitude and  the
appropriate reference system
needs to be selected.

Image taken from
Google Earth using
the Add Placemark

tool.

Latitude Longitude
39.624275° | 20.863215° o

> > H e o e
39.673387° | 20.856032 . . - R X = longitude
39.691272° | 20.848147° Y > latitude

39.659195° 20.930364°
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Figure 42 : Slide 14 of course 4, available via the FuseGl VLE platform.
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In the latter case, the photo to be georeferenced is based on the use of an additional map
such as Google Street View. The purpose of these steps is to place points on the image to be
georeferenced as well as on the map at the samepoints chosen at the samepoints. The more

points there are, the more accurate the georeferencing is (Figure 43).

3. Georeference an aerial photo using a web based map.

* This method uses the OpenStreetMap layer as the reference layer. Firstly go to
Main tool bar>Plugins>Manage & Install Plugins and install the plugin of Street View.

| Web base map.

= A

FuseGl advancing GIS professional skills

2. Georeference process (8/8) \—::* e

* Previous methods involved reading and entering the coordinates manually. In that case you can use an another
georeferenced data source as your input. Using existing open data sources in the georeferencing process.

Street View r’)

Click on a point and choose to enter
the coordinates with the tool From
Map Canvas. Automatically leads you
to select the same point on the web
based map which is already
georeferenced. Repeat for 2 more
GCPs and start the process.

Figure 43 : Slide 15 of course 4, available via the FuseGl VLE platform.

Next, the course provides a reminder of how to use the layer creation tool (Figure 44).
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3. Creating layers (1/2) w S

The main work in QGIS include creating and editing different kind of layers. QGIS provides tools to import and export
layers in different kind of formats.

Layers can be created in many ways, including empty layers from scratch or existing layers. QGIS allows you to create
new Shapefiles, new Spatialite layers or a new GeoPackage layer. Choose Main Tool Bar>Layer>Create Layer.

v Type of layers that QGIS
-\ ~  allows you to create.
=

To create a new Shapefile, choose the right type of geometry (between point, — = j
line, polygon) and the proper Coordinate Reference System. Add the attributes =

of each spatial element by giving a name and type, click on the Add to filed list
button. o=

After entering all the information required, provide a name for the Shapefile.
QGIS will automatically add the .shp extension. The new layer will be added to
the map in order to digitize its the spatial elements, o )=

FuseGl ahancing GIS professionad skill 16

3. Creating layers (2/2) \‘C‘i Erasmus+

When creating a GeoPackage layer, QGIS automatically adds the .gpkg extension. GeoPackage is a standard OGC data
package that can store different types of spatial data. Several layers can be saved In just one GeoPackage.

QGIS also supports the use of a file format called Spatialite that is lightweight. Choose Create Layer>New Spatialite
Layer. Firstly, you should select an existing Spatialite database or to create a new one. Add a name, define the layer
type and specify the CRS. Click OK when you complete importing attributes and QGIS will automatically add the new
layer to the legend.

In order to avoid losing any
Temporary Scratch layers are in-memory layers, meaning that they are not saved data when closing a project

on disk and will be discarded when QGIS is closed. They are used temporarily to with temporary scratch
store features during geoprocessing operations. layers, you can save these
layers to any vector format
* GPX layer format needs to load the GPS plugin first and activate the GPS Tools that QGIS can support.
checkbox.
-‘ koY L3 A > point
line v ® Mot Stations —— -
™~ Mydrography
¢ [ Lond wmen
¢ [ wesetmess — = polygons
FuseGl advancing G professional skils 17

Figure 44 : Slides 16 and 17 of course 4, available via the FuseGl VLE platform.

These processes are essential for a good use of the software and a mastery of GIS. This course
also teaches how to scan, symbology, edit and use attributes. In addition, an exercise to apply
the concepts learned is available at the end of this course. This course gives us many examples
and explanations of the tools that can be used with the QGIS software (Figure 45).

4. Digitization (1/3) ('—-m p—

+ Shapefiles are created in order to digitize spatial elements. Through QGIS you can edit any layer using the right tools.
Go to View>Toolbars and click ok the digitization toolbar. .

= Using the basic digitizing tools, you can perform the following functions.

' 4 Current edits V4 Toggle Editing

Add Feature: Capture Point %3 Add Feature: Capture Line

3 Add Feature: Capture o Nee Featire
Polygon
- < Add Circular String by o -
Add Circular String ('@ Radiu;rcu AEREI0RRY, + Editing starts by choosing the
Toggle Editing option. Additional tool
=
f% ' Nade Tool I Delete Selected buttons will become available once the
editing process starts.
> Cut Features Copy Features
* You can still zoom or pan in the ma
Paste Features [§  Savelayer Edits g ; P AT B
canvas while using any of the digitizing
tools.
FuseGl advancing GIS professional skills 18

Figure 45 : Slide 18 of course 4, available via the FuseGl VLE platform.

Page |33



Then, the course defines and allows the use of tools allowing the digitization of data and new
characteristics useful to the GIS project (Figure 46).

4. Digitization (2/3) i‘:* —

* Depending on the type of feature to be digitized you can choose between:

=

Add point feature = ;| All line feature Add polygon feature

= You will notice that clicking on different layers (points, lines or polygons) activates different digitization tools.

* Left-click on the map area to create the first point and then enter its attributes (name, type, etc). Keep on left-clicking
for each additional point you wish to capture for linear geometries. When you have finished adding points, right-click
anywhere on the map area to confirm that you have finished entering the desirable features.

+ The attribute window will automatically appear in order to enter the information for the new feature.

« Example given: for the digitization of a road network it is necessary to digitize the different highways with tools related
to line features and enter attributes such as allowed speed in each road.

Right-click on a layer>Open Attribute Table. In this window there are useful editing tools between attributes and their
values.

FuseGl advancing GIS professional skills 19

Figure 46 : Slide 19 of course 4, available via the FuseGl VLE platform.

Then, two videos are available in the slideshow to illustrate the digitization of the data and
facilitate the understanding of the manipulations to be carried out (Figure 47).

4. Digitization (3/3) e iy
Erasmus+|
b d

; LY X

7 Use
200¢ Parking
2001 Museum
1957 Town Hal
1995 Schoot
2005 Church

Video 1 Video 2
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Figure 47 : Slide 20 of course 4, available via the FuseGl VLE platform.

Each of the data that is added to the project or created for it has visible data in the layer
parameters or in the attribute table. In addition, it is possible to modify, add or remove this
data (Figure 48).
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5. Editor / Attributes (1/2)

\ * Vertices of a polygon
feature.
= Vertex Table.

FuseGl advarcing GIS professional skilly

S. Editor / Attributes (2/2)

+ Right-click on a layer and choose Open Attribute Table. A
new window will open that displays the feature attrib

—

Every click you made to digitize a feature (either the
perimeter of a lake or a building) it automatically
creates a vertex point.

Activating the Node Tool the Vertex Table displays in
the main workspace of the project. X, Y columns refer
to each vertex coordinates’ according to the selecting
reference system.

QGIS provid lecting, adding, deleting or g
vertices.

To add a vertex, double click near an edge and a new
vertex will appear near to the cursor. To delete a vertex,
select the vertices and click the delete button from
your clipboard.

Also, select a row in the table does select the
corresponding vertex in the map area.

21

-
Erasmus+

of the selected layer.

Note that depending on your QGIS version, some tools
may not be available.

Through the tools given you can hide/organize columns,
filter features, edit attribute values or perform
calculations on the existing attribute values.

.

Editing attribute values can be done by typing the new
value directly in the cell.

Field Calculator = dialog.

box.

FuseGl achancing GIS protessonal skits

=
; T = | Toolbar.
I I TN 2
Attributes given T
by the user. Préview
! types. |

= If you want to calculate the length in km of the roads layer from the QGIS click on Toggle editing mode and open the

* Select Create a new field checkbox to save the calculations into a new field. Add length as output field name and real as
output field type. Double click on function length in the Geometry group to add it into the field calculator expression

22

Figure 48 : Slides 21 and 22 of course 4, available via the FuseGl VLE platform.

Itis also possible to customize the layers and the style of these, whether they are points, lines

or polygons (Figure 49).
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6. Symbology (1/2) ':‘* s

* QGIS offers a dynamic representation of the spatial data. Right symbology is ial to produce functional and easy to
use maps.

* QGIS software provides a large library of colors and symbols to create any symbology for any vector. To change a layer’s
symbology right click on the layer to be edit Layer Properti bole

* Layer’s display (points, lines, polygons) based on the choice of color, symbol,
width or line style.

* In cartography there are specific instructions for the use, size and general

creation of symbols.

# Point Symbols 2 T o
When dealing with points, users have the option of - .
choosing between symbols and colors of the adjacent .
image. QGIS also provides special symbols of various e
toponyms. Apply and then click OK to save your edits,

PusaGl acvancing OIS professionad skils 23

6. Symbology (2/2) \:a ——

» Line Symbols -
| width -

+ There are three basic steps. Style, Color, Width. given in

mm

* The choice of color and line style depends on the respective _-
spatial data to be represented. Displaying data with symbols must ‘t;'"’ ‘ =
follow a logical continuity. SN o

* For ple in the rep ion of the hydrographic network -
streams should be displayed with lower width lines than the main
river. Also, in the rep of road k, each category —

of roads must appear with a different color or line thickness in
order to be visible.
» Polygon Symbols EREEEEOEN
-e @]
* Polygons represent specific land surfaces (water bodies, land uses,
etc). A useful tool for representing polygons in addition to outline
style and fill color is the transparency rate to be selected.
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Figure 49 : Slides 23 and 24 of course 4, available via the FuseGl VLE platform.

In order to better understand all the tools described in the course, an exercise is available
(Figure 50).

7. Practice sdvanciog GIS profesions s
Erasmus+

1. Find your area of interest through Google Earth where longitude and latitude are given. Use the Add Placemark tool to
create Ground Control Points or use a map with known coordinate. Follow the steps given.

2. Create your own layers. Points, lines or polygons depending on the spatial data you need to digitize. Enter the right
attributes.

3. Start digitization of spatial data using the right tools. Check the attribute tables when finishing. Go to Layer Properties
and change symbols.

Practice 2: Search for open data from
Copernicus or your governments websites.
Extract images and maps with contour lines
(https://ngmdb.usgs.gov/topoview/viewer/
,https://cloud.maptiler.com/maps/).
Digitize hydrography networks.

Good luck!

Practice 1: Georeference the
image_1. Create the follow
shapefiles:  Polygons  (sports
fields), Lines (road network)
Attributes needed: Name and
type of each field, year of
construction. Start digitization
and choose the right symbols. 3
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Figure 50 : Slide 25 of course 4, available via the FuseGl VLE platform.

Page |36



3.5 Course 5: Spatial Analysis

This fifth course aims to explain spatial analysis tools as well as spatial queries with location
selection and basic statistics (Figure 51). It allows you to learn more about buffer zones as

well as to master other layer processing tools such as union, clip, intersection
example.

tools for

1. Spatial Analysis

2. Spatial Analysis Tools

3. Basics statistics / Select by Location / Spatial Query
4. Buffer Zones

5. Intersect / Union / Clip

6. More..

FuseGl advancing GIS professional skills

Contents _:w*
Erasmus+

Figure 51 : Course outline 5, available via the FuseGl VLE platform.

First, we find in the course a definition of spatial analyses as well as an overview of the type

of domain that can use these analyses (Figure 52).

* Spatial Analysis extracts or creates new information from spatial data and answers “where” questions.

« Examining the locations, attributes and relationships between the features of spatial data through overlay and other
analytical techniques in order to gain useful information.

* GIS offer several capabilities such as geographic analysis, including geocoding, informative visual displays and
calculation of distance and adjacency.

Spatial
;4 Analysis uses

—i )
. v 4% Urban Social
ey ) i j
b Agriculture ﬁ Forestry (552 Planning @ - Transportation ; Cartography Environment j Studies

* Spatial analysis allows you to solve complex location problems and lends new perspectives to decision-making. It as
the approach to apply statistical analysis to data which has a geographical or spatial aspect.

= The history of spatial analysis is noteworthy for its genesis in a number of different fields nearly simultaneously.

FuseGl advancing GIS professional skills 6

1. Spatial Analysis (1/3) “"""‘“‘* Erasmus+

Figure 52 : Slide 6 of course 5, available via the FuseGl VLE platform.

The course provides an understanding of the conditions under which spatial analyses are

carried out (Figure 53).
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1. Spatial Analysis (2/3) ruseGi .

Erasmus+

* Types of spatial analysis are queries and reasoning, measurements, transformations, descriptive summaries,
optimization and hypothesis testing.

* Spatial lysis include ing distances and shapes, setting routes and tracking transportations, establishing
correlations between objects, events and places via referring their locations to geographical positions.

* It includes all of the f ti and hods that can be applied to geographic data to turn them into useful
information.

* Methods of spatial analysis can be either very simple or very sophisticated.

* Through spatial ysis, you can comb Information from many Independent sources and derive new sets of
information by applying a set of spatial operators.

+ Organizations that use spatial analysis in their work are wide ranging: local and state governments, businesses of all
kinds, universities, etc,

+ Spatial analysis studies the characteristics of places and the relationships between them and requires an underlying
spatial framework in which to locate the spatial phenomena under study.

FuseGl adwancng GiS professional skolly 7

1. Spatial Analysis (3/3) rusest-

Erasmus+

Spatial Analysis / GIS

Hardware Software i\ & Data (6 Process f“‘??‘ Users
. &

9

* QGIS is the most commonly used free open source software for analysis and visualization of spatial data.

* GIS applications are computer-based tools that allow the user to create interactive queries, store and edit spatial and
non-spatial data, analyze spatial information output and presenting them as maps.

* Spatial analysis is playing an increasingly central role in t, hypothesis development and validation of
theoretical constructs.

= GIS and spatial analysis have revolutionized the manipulations of geospatial data in broader sections of the private
and public sector, such as in urban planning, decision making policies, marketing etc.

FuseG advancing GIS professonal skills 8

Figure 53 : Slides 7 and 8 of course 5, available via the FuseGl VLE platform.

The next slide defines spatial analysis tools and explains what thesetools can do, such as
analyzing patterns or modeling spatial relationships (Figure 54).

2. Spatial Analysis Tools (1/2) @ T

* The last decades there was an increasing demand for systems that “do something” other than display maps and
organize data. Researchers and GIS developers aimed to introduce a mean of integrating spatial analysis with GIS
technology.

* Due to the growing demand for spatial analysis tools, new software packages were developed and new tools were
integrated into the existing ones.

* Spatial analysis deals with two distinct types of information. One concerns the attributes of spatial objects, which
includes measures such as area, population etc. The other one concerns location information about the spatial

objects.

« The spatial objects concerned in most analyses are polygons which correspond to measurement zones and statistical
reporting areas.

* There are four core analytical toolsets: measuring geographic distributions, analyzing patterns, mapping clusters and
modeling spatial relationships.

* Tools to perform spatial analysis have been extended over the years to include geostatistical techniques, raster
analysis, analytical methods for business, 3D analysis and network analytics.

FuseGl advancing GIS professional skills 9

Figure 54 : Slide 9 of course 5, available via the FuseGl VLE platform.
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In the course, 6 spatial analysis tools are mentioned such as QGIS, GRASS GIS or Google Earth

(Figure 55).

2. Spatial Analysis Tools (2/2)

g G e
Erasmus+

* There are several software that can perform spatial analysis processes. Free of charge are the following.

G&S

Package Website Main Features
; Easy to use, ability to expand functionality with
QaGls QGIS https: is.org/en/site, Python plugine.
\ "
GRASS Dtfos:/ faiass Ospenion Extensive set of GIS tools for both raster and

vector data.

https://earth.google.com/web/@0
0,0a,22251752.77375655d,35y,0h,

Google Earth “

Easy to use, dynamic graphics, historical maps.

0t,0r
2 http://www.umass.edu/landeco/re | Area, edge metrics. Shape metrics and
FISEstats F §14ts U search/fragstats/fragstats.html fragmentation.
SAGA SAGA thg //www.saga G.nd :'malysns, Terrain  analysis, hydrology
keop doing is.org/en/index.html simulation.
GeoDaSpace @1 https://geodacenter.github.io/ Advanced spatial models for cross section.
FuseGl advancing GIS professional skills 10

Figure 55 : Slide 10 of course 5, available

via the FuseGl VLE platform.

Basic statistics are a method defined in the course since it is very often used to carry out
research concerning scale, geostatistics or classifications (Figure 56).

» Basic statistics

3. Basics statistics / Select by Location / Spatial Query (1/4)

ey 48 ettt
Erasmus+

« Spatial statistics allows you to analyze and understand what is going on in given vector dataset.

relationships (such as distance, area, volume, length, height and/or other spatial characteristics of data.

pattern analysis, scale and zoning, geostatistics, classification, spatial sampling and spatial econometrics.

* From GIS dictionary spatial statistics are defined as “the field of study statistical methods that use space and spatial

* The spatial statistical methods in current use and upon which research is continuing include: spatial association,

database

Traditional and GIS approach of spatial statistics analysis Fig.

FuseGl advancing GIS professional skills

* The effect of the new technology on spatial statistical analysis has led to a broadening of the process of hypothesis

techniques

testing.
eXPLon
histograms, RUN model: tests REPORT results.
- statistics, maps, it on parameters ‘with graphics
graphics
DATA MANIPULATION > 2
G1S APPROACH data reduction, map. BB StAUSLICS, maps, graphics, SPRECIFY models parameters simulations array of graj
ke overlays, Interaction with ‘sensitnity analysis maps and visualization

bootstrap

10f Getis, A (1999). Spatial

statistics. Geographical information systerns, 1, 239-251

11

Figure 56 : Slide 11 of course 5, available through the FuseGl VLE platform.

The course allows to know the path to the basic statistical analysis tool, available in the QGIS

software (Figure 57).
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3. Basics statistics / Select by Location / Spatial Query (2/4)

» Basic statistics

g it
N\ Erasmus+

Goto

Main Toolbar>Vector>Analysis
Tools>Basic Statistics for fields

- e By clicking on the Z icon, a
| = 22 new panel will pop up. Users
nea should specify the layer under
study as the source and select
the right value in the field
- combo box. This is the field
‘ they will calculate statistics for.
[ - The left statistics panel will be

& automatically updated with the

‘ S s mean, median, range etc.)

FuseGl advancing GIS professional skills

| et calculated  statistics  (sum, By b
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Figure 57 : Slide 12 of course 5, available via the FuseGl VLE platform.

The course defines and shows the path of the "select by location" tool. In addition, an example
of use illustrates the slide which facilitates understanding (Figure 58).

3. Basics statistics / Select by Location / Spatial Query (3/4)

» Select by location
* The Select by Location tool allows you to select features based on their
location relative to features in another layer. The selection methods are the

same as in the Select by Attribute dialog box.

* Go to the Main Toolbar>Vector>Research Tools>Select by Location.

* Select by location

* Using this tool allows you to
identify water bodies within a
specific geographical area.

» If you want to select buildings with
two floors (attribute) in a polygon
of a city, use Select by Location
tool.

FuseGl advancing GIS professional skills
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Figure 58 : Slide 13 of course 5, available via the FuseGl VLE platform.

Finally, a final spatial analysis tool is presented, the "spatial query" tool (Figure 59).
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3. Basics statistics / Select by Location / Spatial Query (4/4) W ———

» Spatial Query

« Spatial queries are come to many types of GIS analysis. Spatial queries allows you to select features in a layer by their
spatial relationships with features from another layer.

* The Spatial Query plugin allows you to make a spatial query in a target layer with reference to another layer. The
functionality is based on the GEOS library and depends on the selected source feature layer.

« Possible operators are: Contains, Equal, Overlap, Crosses, Intersects, Touches, Within.
* Examples of spatial queries: features that intersect with other features, features within other features (e.g. hotspot
within a forest area), features with a distance from another area (buildings 20 meters from main roads, industrial areas

10 km from natura areas, schools 10 meters from bus stations), etc.

+ Select the buildings in a perimeter of 50 meters: Il i -

= =
|
. 50 m.

FuseGl advancing GIS professional skills 14

Figure 59 : Slide 14 of course 5, available via the FuseGl VLE platform.

The following slides are devoted to the definition and use of the "buffer" tool (Figure 60).

4. Buffer Zones (1/3) @ Erasmus+

* In Geographical Information Systems, a buffer is a zone that is drawn around any point, line or polygon that
encompasses all of the area within a specified distance of the feature (e.g. 200 meters). This zone is a new polygon
around the selected objects.

* Common types of buffer zones may be greenbelts between residential and commercial areas or zones around natura
areas where any industrial activities are prohibited. Buffer zones can also be border zones between countries, noise
protection zones around airports or pollution protection zones along rivers.

« Buffering is a spatial analysis toll that can be carried out with vector data. It can be done on all three types of vector
data (point, line or polygon) and the result given is a polygon file.

!

| Buffer zones around
point feature.

Buffer zone around
polygon feature.

FuseGl advancing GIS professional skills 15

Figure 60 : Slide 15 of course 5, available through the FuseGl VLE platform.

It is possible to create buffer zones of different diameters (Figure 61).
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4. Buffer Zones (2/3) z"‘“* Erasmus+

= Buffers around polylines, such as road network, do not have to be on both sides of the lines. Users can choose either
the left side or the right side of the line feature.

* Most often buffers are measured in uniform distance. A buffer based on different distances is called variable buffer. A
feature can also have more than one buffer zone. For example, studying land uses changes (natural vegetation,
agriculture areas, artificial surfaces or wetlands) around a water body at 50, 100 or 500 meters gives greater analysis
and better results.

100 meters zone
70 meters zone
50 meters zone

Variable buffer

Buffer zone of 500
meters around the
perimeter of a lake.

« Buffering is an important tool to determine the area covered within a specific
location.

FuseGl advancing GIS professional skills 16

Figure 61 : Slide 16 of course 5, available through the FuseGl VLE platform.

The path to the "buffer" tool is described in the fifth course. An example of the use of the tool
is also available and provides a better understanding of the use of this tool (Figure 62).

4. Buffer Zones (3/3) \"\"“ Erasmus+

« Buffer zones around polygon features are usually extended outward from a polygon boundary but it is also possible to
create a buffer zone inward from a polygon boundary.

| Geoprocessing tools is
a set of tools for
processing geographic
and related data and
performing spatial
| operations.

* In order to create a buffer zone around a feature go to the
Main Toolbar>Vector>Geoprocessing Tools>Buffer.

Choose the homell )| Gutfer
vector layer -
under study.

Choose the
distance of
the  buffer
zone to be
created.

Before buffering | After buffering

FuseGl advancing GIS professional skills 17

Figure 62 : Slide 17 of course 5, available through the FuseGl VLE platform.

Other tools described in this course include the "intersection", "union" and "cut" tools. The
"intersection" tool is used to extract the features superimposedbytwo layers (Figure 63).
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5. Intersection / Union / Clip (1/4) \-\-:* _—

» Intersection

* Intersect tools allow you to exclude the area that is not overlapping. The
algorithm combines features from the input layer and the intersect layer
resulting in features that cover both layers’ features.

' Intersection

Oterove : One layer  containing
E features to be combined.

Second layer containing the
features to be combined.

= Where to save the
intersection layer. Can
be saved to file, a
& temporary file or a
e ~ | memory layer.

FuseGl advancing GIS professional skills
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Figure 63 : Slide 18 of course 5, available via the FuseGl VLE platform.

The "union" tool verifies overlaps between two-layer entities and creates separate entities for
overlapping and non-overlapping parts (Figure 64).

5. Intersection / Union / Clip (2/4) W o

» Union

Union tool allows to merge two layers into one new layer. Attributes from both input layers are copied. It maintains all
input features boundaries and attributes in the output feature class.

* Go to Main Toolbar>Vector>Geoprocessing Tools>Union. ‘ E ‘

| 1. Choose the two input layers,
2. Choose the path to save the
output layer,
3. Run the process.

FuseGl advancing GIS professional skills

Figure 64 : Slide 19 of course 5, available via the FuseGl VLE platform.

The "cut" tool extracts the common parts between two layers by creating a new vector layer
(Figure 65).
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5. Intersection / Union / Clip (3/4)

R L)
Erasmus+

* Like a cookie-cutter the output is a new clipped output. The input layer can be points, lines or polygons and the clipping
layer must be a polygon.

» Clip

* Clip tool creates spatial cut-out of the data of a particular area. The input layer
is the layer which you want to retrieve your data from. Clipping allows to clip
the feature with the defined boundary line.

* Users lly d load a d: that is larger than the area they need. This
will slow processing time and data loading.

* The main difference between clip tool and intersect toll is the resulting attributes, When you run the clip tool, only the
input features attributes will be in the output. When using the intersect tool, the attributes from all features will be in
the output.

= Clipping tool is one of the most important geoprocessing tools. It creates a new feature class concerning a study area or
a specific area of Interest. When analysts and researchers deals with large volumes of data, they can discard the

unnecessary spatial information.

FuseGl advancing GIS professional skils

S. Intersection / Union / Clip (4/4)

* Go to Main Toolbar>Vector>Geoprocessing Tools>Clip.

Input vector
\ layer to be
clipped.

Sasenn

changes in the perimeter of any water body.

FuseG! advancing GIS professiona skily

To the example given the Corine Land Cover of 2012 was used as the input vector layer clipped by the buffer zone of 500
meters giving the result on the right image. Through this process, researchers are able to investigate the historical land use

20

[
N Erasmus+

21

Figure 65 : Slides 20 and 21 of course 5, available via the FuseGl VLE platform.

3.6 Course 6: Cartography

The sixth course teaches us the principle of cartography, but also how to create our own
maps using the QGIS software (Figure 66). The mapping tool allows you to export the layers
present in the project into data that can feed a map. This course teaches us how to change
the symbols and colors of the map, create the legends and how to export the document.
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1. Principles of Cartography
2. Cartography Target

3. Map Layout

4. Symbols & Colors

5. Export

6. More..
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Figure 66 : Course outline 6, available via the FuseGl VLE platform.

This course begins with the basics and principles of cartography (Figure 67).

1. Principles of Cartography (1/4) FUSERI

Erasmus+

* Cartography is the study and practice of making and using maps and concerns the sub-scale display of the Earth’s
surface using appropriate colors and symbols.

* Combining science, aesthetics and technique, cartography builds on the premise that reality (or an imaged reality) can
be modeled in ways that communicate spatial information effectively.

+ The first samples of maps come from Babylon, while finds from Egypt are remarkable.

1500 b.C. 500 b.C. 1400 1569 1662 > 1682 > 1849
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Figure 67 : Slide 6 of course 6, available via the FuseGl VLE platform.

The following slides are slow reminders and define the principles of mapping (Figure 68).
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1. Principles of Cartography (2/4) W e

+ Cartography is closely related to Geography, since maps are one of the main means of presentation and study
geographical data.

* GIS applications and GIS software aim to represent geospatial data and results through maps, so Cartography can be
closely related to GIS too.

* Maps are models that represent various elements from the real world on a piece of paper.

+ Cartographic principles are laid out to guide GIS users through the process of transforming GIS data into attractive,
useful maps for print and display.

* In cartography there is difference between principles and rules contribute to the design process. Rules can’t guarantee
a good outcome like the principles that must be followed.

= Statements of cartographic design:
» The purpose of design is to focus the attention of the user.
» The principles of cartographic design are timeless, the results are not.
7 The rules of cartographic design can be taught and be learnt, principles and concepts have to be acquired.

FuseGl advancing GIS professional skills 7

1. Principles of Cartography (3/4) 3\—“ ——

» The five (5) principles of map design (as written from the British Cartographic Society Design Group):

1. Concept before compilation
* Without a grasp of concept, the whole of the design process is negated. Once concept is understood, no design
or content feature will be included which does not fit it.
= Design the whole before the part. Design comes in two stages, concept and parameters and detail in execution.
Design once, devise and design again.
= User first, user last. What does the user want from this map? What can the user get from this map?

2. Hierarchy with harmony
* Important things must look important and the most important thing should look the most important.
* Harmony is subliminal. Successful harmony leads to repose. Perfect harmony of elements leads to a neutral
bloom.

3. Simplicity from sacrifice
+ Great design tends towards simplicity. It’s not what you put in that makes a great map but what you take out.
* The map design stage is complete when you take nothing else out.
* Content may determine scale or scale may determine content and each determines the level of generalization.

FuseGl advancing GIS professional skills 8

1. Principles of Cartography (4/4) \-::* ——

4. Maximum information at minimum cost
* How much information can be gained from this map, at a glance. Functionality not utility. Design makes utility
functional.
* The spark which makes a map special often only comes when the map is complete.

5. Engage the emotion to engage the understanding
* Design with emotion to engage the emotion. Only by feeling what the user feels can we see what the user sees.
* Designers use cartographic fictions, cartographic impressions, cartographic illusions to make a map.
= Good design is a result of the tension between the environment and the designer. Design uses aesthetics but the
principles of aesthetics are not those of design.

* Cartographers are not just prettying maps up.

* The philosophy is simple:

Beauty (aesthetics) focuses the attention,

Focusing the attention is the purpose of map design and
User first, user last.

YVVY

FuseGl advancing GIS professional skills 9
Figure 68 : Slides 7, 8 and 9 of course 6, available via the FuseGl VLE platform.

Next, the course shows us the basic functions of a map and what types of information can be
found in a map (Figure 69).
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2. Cartography Target (1/2) W T

* The main purpose of Cartography is to convey to the user information related to geospatial data.

* The purpose of the cartographer is to enhance the ability of the user to retrieve the geographical information
contained in map and relate it to the real world.

* Maps are used in two basic functions:
» They are a mean of storage of geospatial information,
» They provide a picture of the world around us so we can easily understand spatial patterns, spatial relationships
and environmental complexity.

* Maps can tell us:
» Where something it is,
7 (Sometimes) When it is,
What is close to something, how close or away, in what direction or how we can go there,
What other things are there and
If there is any relationship between them.

YV Y

* Each map has a predefined purpose and is a mean of communication between people for the transmission of
information.

FuseGl advancing GIS professional skills 10

Figure 69 : Slide 10 of course 6, available through the FuseGl VLE platform.

In addition, the course indicates what types of maps can be represented using GIS (Figure 70).

2. Cartography Target (2/2) “:;* s

* Depending on their scale
Isentation * Depending on their function (use)

Creation &
Usage

Political Map (national boundaries)
Physical Map (water bodies, mountains)
Topographic Map

Y 3 * Climatic Map (temperature, humidity)
Q Gegpa o * Road Map
» * Economic Map
a
e 9
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Figure 70 : Slide 11 of course 6, available via the FuseGl VLE platform.

After processing the data and the different layers, it is possible thanks to the QGIS software
to create cartographic representations. These map representations follow 5 design principles
presented in the next slide (Figure 71).
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3. Map Layout (1/5) *\«* Erasmus+

= Cartographers apply the five following design principles:

» Visual contrast
It relates to how map features and page elements contrast with each other and their background. The higher the contrast
between features, the more something will stand out, usually the feature that is darker or brighter.

> Legibility
It is the ability to be seen and understood and it depends in good decision-making for selecting symbols that are familiar
and choosing appropriate sizes so that the results are effortlessly seen and easily understood.

» Figure-Ground Operation
It is the spontaneous separation of the figure in the foreground form an “amorphous” background.

» Hierarchical Organization and
Separating meaningful characteristics so that some types of features will be seen as more important than other kinds of

features, and some features will seem more important than other features of the same type.

» Balance
It refers in the organization of the map and other elements on the page (scale, north arrow, legend).

FuseGl advancing GIS professional skills 12

Figure 71 : Slide 12 of course 6, available via the FuseGl VLE platform.

Itis possible to add all the basic elements of a map such as the title, the arrow indicating north,
the scale bar, the legend and the map itself (Figure 72).

3. Map Layout (2/5) ﬂ Erasmus+

* The basic map elements are the title, the map body, the legend, the scale and the north arrow.

* Scale represents the ratio of a distance on the map to the actual distance in the real world and displays in map units
(meters, feet or degrees). At the same time, legend explains all the symbols used on a map.

POPULATION OF THE SEVEN CONTINENTS |~ ™ |

J's

| North Arrow F—

body

Scale bar |«— = ], hy "\\, Main map ‘
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Figure 72 : Slide 13 of course 6, available via the FuseGl VLE platform.

All of these items listed above are available in the QGIS mapping workspace (Figure 73).

Page |48



3. Map Layout (3/5) f‘:;* Erasiugs

* QGIS is an open source GIS software enabling the user to visualize, manage, edit, analyze data
and compose printable maps. « sop B ¥

* QGIS has a tool called Print Layout (Main menu>Project>New Print Layout) that allows you to
take GIS layers and package them to create maps. It allows the creation of maps and addition of
essential map elements that can be printed or published.

Add Map s

%% | Add Picture

Add Title Main Workspace AR

Add Legend of maps creation
in QGIS

“% | Add Scale Bar

A | Add North Arrow A',T.’.

FuseGl advancing GIS professional skills 14

Figure 73 : Slide 14 of course 6, available via the FuseGl VLE platform.

It is possible to change the titles of the legend and the color and appearance of the symbols
(Figure 74).

3. Map Layout (4/5 o reian
b (4/5) S Erasmus+
* On the right side of the window you can edit the elements of the map.
1 [2] =
T Write the title.
The elements presented
e e e o | on the map’ legend are
Click here in order to \ displayed here.
o change the style and | ey
— the size of the title. preoyd =
- g Title, Title, Title
:

* QGIS allows you to perform a variety of edits. You * By clicking on the legend button we can edit the
can add color or an image as a background of your elements and symbols displayed on the map. Colors,
map’s title. size and style.
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Figure 74 : Slide 15 of course 6, available via the FuseGl VLE platform.

In addition, elements such as the arrow indicating north or the scale bar are customizable
(Figure 75).

Page |49



3. Map Layout (5/5) \*:“ Erasmus+

o jCIick here to change units
o / | (kilometers, meters etc.)

Click here to change scale i

"/' bar’s format. [

A
Ao idA s
Choose the right symbol s
to represent the north * The most used scale bar symbols:
arrow.
- Single 0 1 2Mm
Box —
Double 0 1 2w
B Box —
* The most used north arrow symbol: A Line Ticks
0 24
Middle AN
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Figure 75 : Slide 16 of course 6, available via the FuseGl VLE platform.

In order to have a better visibility of the information on the map, it is possible to customize
the symbols used. To do this, go to the "settings" of the layer to modify and open the
"symbology" tab (Figure 76).

4. Symbols & Colors (1/4) \‘::* Erasmus+

* Layers in QGIS represent geospatial data that describe objects or features. Symbols used to describe objects can have
shape and color.

- Q A ‘ Airport & Swimming pool
- O A ‘ Hotel o Airport
A *x

| ®
* Continuous attributes can’t be represented by single symbols either the variables
with multiple values. o Symbots

| Q) Layer Properties — Clip| B S Gyabol

< & Graduated

* In order to represent temperature we need to use graduated colors depending on its
values.

B Rulebased
[0 inverted Polygons

* On the other hand, there are variables (e.g. land uses) that cannot be described by
single symbols. To represent land uses on a map it is necessary to use categorized
colors. Each value takes a certain color in order to be recognized.
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Figure 76 : Slide 17 of course 6, available through the FuseGl VLE platform.

In addition, it is possible to categorize information, add information, or remove information
(Figure 77).
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4. Symbols & Colors (2/4) @ Erasmus+

* Colors convey: meaning, emphasis, aesthetics, abstraction and reality.

* Colors are used to indicate different values of a variable. QGIS allows you to use colors for each class so that
visualization becomes easier. The land uses visualization is a representative example of using categorized colors.

* Right click on the layer Properties>Symbology. -

« Choose the method you wish to represent the information given by u
the geospatial data. For the example given, we choose the o o
categorized method. 111 | Continuous urban fabric
112 | Discontinuous urban fabric
* In the next step, you need to select the value from which the
categorization will be made. (Remember that these values are given

by the user during the digitization phase.) And then click Classify.

142 | Sport & leisure facilities

211 | Avable land

212 | Arableland

242 | Complex cultivation patterns

* You can eitheradd # orremove = anyvalues. 221 | Natural grassland

323 | Sclerophyllous vegetation

* Every code represent a unique land use as given in Corine land cover
maps. The user is responsible for the color rendering of each code.

324 | Transitional woodland-scrub

411 | Inland marshes
512 | Water bodies
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Figure 77 : Slide 18 of course 6, available via the FuseGl VLE platform.

In the course, there are examples of card personalization. Each of the colours represents a
different environment such as agricultural land or artificial surfaces (Figure 78).

4. Symbols & Colors (3/4) ‘\"':* Erasmus+

P

Land Uses in a perimeter of 500 meters around Lake Pamvotis.

e

Coastal Wetlands

| Choose the
right color.

Water Bodies

Artificial Surfaces

Agricultural Areas

- : Choose the
_— = right style.
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Figure 78 : Slide 19 of course 6, available via the FuseGl VLE platform.

Another example of map customization is available. This time, it is the customization of layers
thanks to the "graduated" option in the "symbology" section of the layer parameters that is
presented (Figure 79).
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* Graduated colors:

114

Surface air temperature anomaly for November 2021

- T

. & {

(Data: ERAS. Reference pariod 10912000, Credit CISECMWF)

- Goemioss CEcmwr G

mate.copernicus.eu/surface-gir-temperature

Depending on the map to be created the right color ramp should
be selected.
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4. Symbols & Colors (4/4) r::* Erasmus+

Figure 79 : Slide 20 of course 6, available through the FuseGl VLE platform.

Finally, all cartographic representations can be exported and saved in PDF for example

(Figure 80).

* When it comes to export your Map. Main menu (of New Print Layout)>Layout>Export.

* QGIS allows you to export the map you have created as an image, or as scalable vector
graphics (.svg) file or as .pdf.

* Export as an image is the most common form to export your map so you can use it for
your writing or presentations.

[ Land Uses in a perimeter of 500 meters around Lake Pamvotis ‘

Final Result:
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Erasmus+

Figure 80 : Slide 21 of course 6, available through the FuseGl VLE platform.

3.7 Course 7: Grass GIS

The seventh course introduces the basics for using another software, the Grass GIS software.
This is downloaded and installed along with the QGIS software (Figure 81). This course
presents us the possible uses of this software, its workspace. Like QGIS software, this software
uses raster and vector data; In particular, it allows the processing of images and the processing

of public data.
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1. About GRASS

2. GRASS workspace

3. Working with raster & vector data
4. Image Processing

5. Public Data Repositories

6. More..
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Figure 81 : Course outline 7, available via the FuseGl VLE platform.

The seventh course introduces the GRASS GIS software, the follow-up of this course will then
allow the user to master the basics of the software to be able to use it in addition to QGIS
(Figure 82).

1. About GRASS (1/2) “:‘* Erasmus+

* GRASS comes from the words Geographic Resources Analysis Support System. It is a geographic information system
(GIS) used for geospatial data management and analysis, image processing, producing graphics and maps, spatial and
temporal modeling and visualizing.

* GRASS GIS is a free and open source GIS software firstly released on 1984. The following is the official \
GRASS GIS logo. V
A\
* Whereas QGIS focuses more on cartography and map making, GRASS GIS focuses more on data

processing and analysis. GRASS

* Through GRASS you can handle raster, topological, vector and graphic data. It is licensed and released under the GNU
General Public License (GPL). It runs on multiple operating systems, including Windows & Linux.

* The GRASS development team is a multinational group consisting of developers at many locations. GRASS is one of the
eight initial software projects of the Open Source Geospatial Foundation.

* GRASS was developed in 1982-1995 by the U.S. Army Crops of Engineers Construction Engineering Research Laboratory
(CERL) in Champaign, Illinois to support land management at military installations.

FuseGl advancing GIS professional skills 6

Figure 82 : Slide 6 of course 7, available through the FuseGl VLE platform.

The first slides introduce and define the principles for using the GRASS GIS software (Figure
83).
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1. About GRASS (2/2) *::* ——

« The idea of Open Source software has been around as long as software has been developed. Over the past few years a
growing number of Open Source GIS, Web mapping and GPS projects has been established with different goals.

* In February 2006, the Open Source Geospatial Foundation has been created to support and promote worldwide use
and collaborative development of Open Source geospatial technologies and data.

* GRASS is a raster/vector GIS combined with integrated image processing and data visualization subsystems.

* For the GRASS users, the license offers various advantages. Full access to the source code, low cost and access to the
new features and capabilities developed between the releases.
=
* GRASS can be loaded as a plugin by clicking on Plugins>Manage and Install
Plugins through QGIS. It may be already downloaded as a shortcut when
you download QGIS software.

* You can either freely download GRASS software from the main GRASS web
site: https://grass.osgeo.org/download/.
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Figure 83 : Slide 7 of course 7, available via the FuseGl VLE platform.

It is possible to use the GRASS GIS software in addition to the QGIS software. In addition,
GRASS GIS can be used for scientific research or engineering applications (Figure 84).

2. GRASS workspace (1/4) r‘\:* Erasmus+

* GRASS is designed as an environment in which tools that perform specific GIS computations are executed.

= There is cooperation between the GRASS and QGIS projects. Recent versions of QGIS can be executed within the GRASS
environment.

* Since then, GRASS has evolved into a powerful software suite with a wide range of applications in many different
scientific research and engineering.

' GRASSGIS

Beingtag alwenced progudal secnplogics to the woekd

* GRASS is also used in academic and commercial settings around the world
and in many government agencies including NASA, NOAA, USGS and many
environmental consulting companies.

. Selecting the GIS Database directory

. Selecting the Location (a project)

. Selecting the MAPSET (a subproject)

. Location Wizard

. Download a sample Location

. Start GRASS: Once you have selected an existing location/mapset or
defined a new one, you can enter GRASS.

OV h WNE
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Figure 84 : Slide 8 of course 7, available through the FuseGl VLE platform.

The next slide describes the GRASS GIS application workspace (Figure 85).
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2. GRASS workspace (2/4) W Erasmus+

» Database: GRASS data is organized on a database which is essentially a dedicated file folder structure.

To create the GRASS database:
1. Find a place on your disk where you have write access and that has enough disk space to hold your spatial data.
2. Create a subdirectory that will hold the general GRASS database.

» Location: It is defined by its coordinate system, map projection and geographical boundaries. The subdirectories and files
defining a Location are created automatically when GRASS is started the first time with a new location. It is important to
understand that each projection stays in its own location.

7 Mapsets: Each location can have many mapsets. Each mapset is a location’s subdirectory. New mapset can be added as
GRASS startup.
Permanent: They usually contain read-only data that is visible by all users.
Owner: They are created by users and represent specific study areas in a location.

» Region: It is a subset of location and sets the boundaries for a master map. /
/

o e

Owner
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Figure 85 : Slide 9 of course 7, available through the FuseGl VLE platform.

The GRASS GIS database can be accessed directly from QGIS by installing an extension of QGIS
(Figure 86).

2. GRASS workspace (3/4) @ Erasmus+

* Once you load the Plugin go to the Main menu>Plugins>GRASS. The GRASS plugin provides access to GRASS GIS
databases and functionalities. The following main features are provided with the toolbar menu when you start the
GRASS plugin:

A Open Mapset A& | Create new GRASS vector

<
o | £

“ | New Mapset Edit GRASS vector layer

4 4 | Close Mapset A Open GRASS tools
4 | Add GRASS vector _ | Display current GRASS
& layer A region

% ERdi S5 raster % | Edit current GRASS region
layer

* You can load vector or raster layers using the appropriate button on the toolbar menu from an existing GRASS location
or you can create a new GRASS location with QGIS and import some raster and vector data for further analysis with the
GRASS Toolbox.

* GRASS data are stored in a directory referred to as GISDBASE. This directory must be created before you start working
with the GRASS plugin in QGIS. The GRASS GIS data are organized by projects stored in subdirectories called locations.
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Figure 86 : Slide 10 of course 7, available via the FuseGl VLE platform.

Once the extension is installed, it is very simple to use the data from GRASS GIS through QGIS
(Figure 87).
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2. GRASS workspace (4/4) \‘:* Erasmus+

/' Main menu

Ay Import, export and link data |

T

o®
Manage maps |

Computational region

Raster

Vector ‘

Imagery

3D raster

Database

Temporal
GUI tools

I Layers / Console / Modules / Data / Python
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Figure 87 : Slide 11 of course 7, available via the FuseGl VLE platform.

Thanks to GRASS GIS, it is possible to process raster or vector type data information. First, the

course specifies how to process raster information through GRASS (Figure 88).

3. Working with raster & vector data (1/4) \-::* —

» Raster data processing in GRASS GIS

+ A raster map is a data layer consisting of a gridded array of cells. It has a certain number of rows and columns, with a
data point in each cell. These may exist a 2D grid or as a 3D cube made up of many smaller cubes.

« The geographic boundaries of the raster map are described by the north, south, east and west fields.

* Asageneral rule in GRASS GIS:
1. Raster output maps have their bounds and resolution equal to those of the current computational region.
2. Raster input maps are automatically cropped/padded and rescaled to match the current region.
3. Raster input maps are automatically masked if a raster map named MASK exists. The MASK is only applied when
reading maps from the disk.

* For importing scanned maps, the user will need to create a x,y location, scan the map in the desired resolution and save
it into an appropriate raster format (e.g. tiff, jpeg, png) and then use r.in.gbal. to import it. Based on reference points
the scanned map can be recified to obtain geocoded data.

* GRASS raster map processing is always performed in the current region settings, i.e. the current region extent and
current raster resolution is used.

FuseGl advancing GIS professional skills 12

Figure 88 : Slide 12 of course 7, available via the FuseGl VLE platform.

Many commands are available to create and analyze raster data using GRASS (Figure 89).
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3. Working with raster & vector data (2/4)

» Raster Commands

g G ot

Erasmus+

Generates watershed subbasins raster Creates/modifies the color table associates with a
r.basins.fill r.colors
map raster map
Blends col ts of two rast 5 %
r. blend e or' compo_nen SOl WO PRt r.colors.out Exports the color table associated with a raster map
maps by a given ratio
Creates s raster. inap showing buff.er Locates the closest points between objects in two
r.buffer zones surrounding cells that contain r.distance :
raster points.
non-NULL category values
b arve Generatasstream channels S hibin :::lzt:rt a binary raster file into a GRASS raster map
Creat T taini A
r.circle it ra§ RN ax.mng A rin.png Imports non-georeferenced PNG format image.
concentric rings around a given point
Recatggonzes tA] raster. mepby Export a GRASS raster map as a non-georeferenced
r.clump grouping cells that form physically r.out.png PNG Iage
discrete areas into unique categories BS:

More at: https://grass.osgeo.org/grass76/manuals/raster.html|
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Figure 89 : Slide 13 of course 7, available via the FuseGl VLE platform.

In a second step, the course specifies how to process the information of a vector through the
GRASS GIS application (Figure 90).

etc.).

3. Working with raster & vector data (3/4)

» Vector data processing in GRASS GIS

FuseGl advancing GIS professional skills

* A vector map is a data layer consisting of a number of sparse features in geographic space. These might be data points,
lines, polygons, volumes or some combination of all these.

« Typically each feature in the map will be tied to a set of attribute layers stored in a database (road names, geologic type

* The v.in.ogr module offers a common interface for many different vector formats. Additionally, it offers options such as
on-the-fly creation of new locations or extension of the default region to match the extent of the imported vector map.

* With v.external external maps can be virtually linked into a mapset, only pseudo-topology is generated but the vector
geometry is not imported. GRASS vector map processing is always performed on the full map. If this is not desired, the
input map has to be clipped to the current region beforehand (v.in.region, v.overlay, v.select).

* GRASS is a topological GIS. This means that adjacent geographic components in a single vector map are related.
Topological representation of vector data helps to produce and maintain vector maps with clean geometry as well as
enables certain analyses that can not be conducted with non-topological data.

iy 5 it i
\ Erasmus+

14

Figure 90 : Slide 14 of course 7, available through the FuseGl VLE platform.

Many commands are available to create and analyze vector data using GRASS (Figure 91).
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3. Working with raster & vector data (4/4) W o

» Vector Commands

Creates a buffer around vector features Removes a vector feature from a vector map
v.buffer v.db.droprow > :
of given type through attribute selection
v.build Creates topology for vector map v.db.droptable | Removes existing attribute table of a vector map
v.class Classlﬁgs attrlbyte CHEL v.db.select Prints vector map attributes
thematic mapping
vcli Extracts features of input map which R lirane Converts 2D vector features to 3D by sampling of
v.elp overlay features of clip map v.orap elevation raster map
Vichitay Parforne e lnctar  dantification Vedit Edlts.a Yectur map, allows adding, deleting and
modifying selected vector features
v.colors Creatgs/ m°d.' e Elbibkle v.generalize Performs vector based generalization
associated with a vector map
%I region Creates a v.ector polygon from the Y oatch Creates a new vector map by combining other
current region extent £ vector maps
More at: https://grass.osgeo.org/grass78/manuals/vector.html
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Figure 91 : Slide 15 of course 7, available via the FuseGl VLE platform.
The GRASS GIS software also allows raster data to be processed as images (Figure 92).

4. Image Processing (1/2) ‘\"‘i Erasmus4

+ Satellite imagery is commonly stored in Digital Numbers (DN) for minimizing the ge vols i.e. the originall

s 5’ Y

sampled analog physical value (color, temperature, ets) is stored a discrete representation in 8-16 bits.

* To obtain physical values from DNs, satellite image providers use a liner transform equation (y=a*x+b) to encode the
radiance-at-sensor in 8 to 16 bits. DNs can be turned back into physical values by applying the reverse formula (x-
(y+b)/a).

* In GRASS GIS, there are two ways to apply atmospheric correction for satellite imagery. A simple, less accurate way for
Landsat is with i.landsat.toar, using the DOS correction method.

+ Image data are identical to raster data However, a couple of commands are explicitly dedicated to image processing.

* Asageneral rule In GRASS:
1. Raster/imagery output maps have their bounds and resolution equal to those of the current region.

2. Raster/imagery input maps are ically cropped/padded and rescaled (using ighb pling) to
match the current region.

*  GRASS raster/imagery map processing is always performed in the current region settings, ie. The current region extent
and current raster resolution Is used. If the resolution differs from that of the input raster map(s), on-the-fly resampling
is performed (nearest neighbor resampling).

FuseGl advarcing GS profeisional shilly 16

4. Image Processing (2/2) @ Erasmus+

I\

= An Image processing system has at least five elements: image input, image ge, Image ysis, accuracy
and information reporting.

* Single and multispectral data can be classified to user defined land use/land cover classes. In case of a single channel,
segmentation will be used. GRASS supports the following methods:

* Radiometric classification:
o Unsupervised classification (i.cluster, i.maxlik) using the Maximum Likelihood classifi

method.
o Supervised classification (i.gensig or g.gul.iclass, i.maxlik) using the Maximum Likeli
classification method
* Combined radi tric/| ic | t base) classification:

o Supervised classification (i.gensigset, i.smap)
* Object-oriented classification:

o Unsupervised classification (seg; ion based: i.seg! )
* In case of using multispectral data, impr of the lution can be gained by merging the panchromatic channel
with color channels. GRASS provides the HIS (i.rgb.his, i.his.rgb) ant the Brovey and the PVA transform (i.pansharpen)
methods,

* Atmospheric effects can be removed with i.atcorr. Correction for topographic/terrain effects is offered in i.topo.corr.

FuseGl advancing GIS professional skits 17

Figure 92 : Slides 16 and 17 of course 7, available via the FuseGl VLE platform.
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Finally, it is possible to find public data repositories in the course, via links, to access useful
data to obtain information on the biosphere or the environment for example (Figure 93).

5. Public Data Repositories (1/2) ﬂ A

* Atlas of the Biosphere

In this website you will find maps of environmental variables, human impacts and land use. The Center for Sustainability
and the Global Environment brings together researchers from the natural, health and social sciences, engineering and other
fields to study problems stemming from interactions between environmental systems, natural resources and human activity,
and to inform technology and policy solutions, httos //sage nelson wisc edu/

+ National Wetlands I y (NW1)

The National Wetlands Inventory (NWI) has been producing wetlands maps geospatial wetland data for the United States
since the mid 1970s. Maps and geospallal data developed by the NW1 is avallable onlme and can be downloaded. By HUC 8
Watershed Boundary or by State. 1 [[www.fws gov/wetlands/Data/Data-Download.htm!

* NOAA National Center for Envi tal Information

The National Center for Environmental Information is the world’s largest provider of weather and climate data. NOAA
manages one of the lavgesx archives of atmospheric, coastal, geophysical and ocean research In the world.

https://www.r noaa.gov/
Pune Gl sdvancing GIS professlonad skilly 18

5. Public Data Repositories (2/2) ..:..* o

* Solil Climate Analysis Network (SCAN)

SCAN is a conti climate itoring program that is an outgrowth of the SM/ST Pilot Project. The SM/ST Pilot Project
was designed to examine network communications, sensors, data collection electronics, data management and climate
infor I y ntt [/www.wee.nres.usda.gov/scan/

o Natianal B ble Energy Lab v

NREL advances the science and engineering of energy efficiency, sustainable lransponation and renewable power
technologies and provides the k ledge to | and op energy sy https://www.nrel gov/index.htr

* USGS National Water-Quality Assessment (NAWQA)

The NAWQA project is a leading source of scientific data and knowledge for development of science-based policies and

management strategies to improve and protect water resources. hitps://www usgs gov)
*+  Multistate Aquatic R Information System (MARIS)

MARIS Is a cooperative effort between state and federal agencies to share fisheries Information collected as part of ongoing
sampling programs.
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Figure 93 : Slides 18 and 19 of course 7, available via the FuseGl VLE platform.

3.8 Course 8: Hydrological Analysis and QGIS Tools

The eighth course is entirely focused on one discipline, hydrology. This course is therefore
more specific since it is directly related to this field. Nevertheless, it is not inaccessible to
people who do not know this field. It consists of an introduction to hydrology and a
presentation of software used for hydrology. We can also find a description of the useful tools
and the procedure to follow for a hydrological analysis (Figure 94).
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1. Introduction to Hydrology

2. Hydrological Software

3. Hydrological Analysis - Toolboxes
4. Digital Elevation Model (DEM)

5. Flow Direction — Catchment Area

6. More..
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Contents ;ﬁ:—“
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Figure 94 : Course outline 8, available via the FuseGl VLE platform.

This course learns, for example, how to use GIS to define a catchment area or flow direction,

as well as the basics of hydrology (Figure 95).

important subject for our life and our environment.

* The field of hydrology deals with the occurrence, movement and
storage of water in the earth system.

* The process of water circulating from precipitation in the
atmosphere falling to the ground, travelling through a river basin
(or through the entire earth system) and then evaporating back to
the atmosphere is known as the hydrological cycle (Jalas, J.D.,
2014).

» Hydrological variables began to be quantified not before the 17t
century.

* The cycle for water may be short or it may take millions of years.

FuseGl advancing GIS professional skills

1. Introduction to Hydrology (1/2) -ﬁ —

* Hydrology is an extremely important field of study, dealing with one of the most valuable resources on Earth: water.

Scientists dealing with hydrology are called hydrologists. Hydrology treats all phases of the earth’s water and is a very

The Water Cycle (https://www.istockphoto.com;

Figure 95 : Slide 6 of course 8, available through the FuseGl VLE platform.

The first slides introduce hydrology to participants who are not in this field or to make some

reminders for those working or studying in the field of hydrology (Figure 96).
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1. Introduction to Hydrology (2/2) -\-* i

* There are many pathways the water may take in its continuous cycle of falling as rainfall or snowfall and returning to
the atmosphere.

* The engineering hydrologist, or water resource engineer is involved in the planning, analysis, design, construction and
operation of projects for the control, utilization and management of water resources.

* Hydrologists apply scientific knowledge and mathematical principles to solve water-related problems in society:
problems of quantity, quality and availability.

+ Practical applications of hydrology: design and operation of hydraulic structures, water supply, irrigation, drainage,
hydropower generation, flood control or wastewater treatment and disposal.
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Figure 96 : Slide 7 of course 8, available via the FuseGl VLE platform.

Hydrological analysis tools are a very important resource in this area. GIS software is used, but
river modeling software or hydraulic modeling software is also used (Figure 97).
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2. Hydrological Software (1/2) @ L —

* Hydrological analysis tools are important resources and are used in a variety of programs to define how the geographic
range of an area interacts with water.

* Hydrological analysis through graphic Information Systems can help researchers identify the source and pathway of
;roundwam A varle(y of pmgnms can be used to perform hydrological analysis including ARCGIS, QGIS, ILWIS and
SAGA GIS.

r hical lon m
* QGIS, a free and open source software, offers hydrology tools for performing hydrological o | S
lysis and creating digital elevati dels. It is the most popular GIS tool in Water '\G
Resources,

* SAGA GIS is a powerful software containing tools for spatial analysis and characterization of
basins. The interpolation options in SAGA GIS are better implemented than in other free and
commercial software,

Web: htto://www.saga-gis.org/en/index.himl s o s‘m

FuseGl aduancing GiS profeisional shilly 8
2. Hydrological Software (2/2) @ Erasmus+
7 River Modeling

* HEC-RAS is developed by the U.S. Army Corps of Engineers. It helps evaluating the flow depth,
velocities and flooded zones. The Hydrologic Engineering Center (HEC) developed the River Analysis
System (RAS) to aid hydraulic engi s in ch | flow analysis and floodplain determi
Web: https://www.hec usace army.mil/software/hec-ras/

.

* iRIC is a softy developed to provide a ¢ lete river simulati i and its results can be Ii
exported and used for anaiysls, mitigation and di pr ion, through the visual 1y of river faic
simulation results. Web: https //I-ric org/en/ o s seeee

7 Hydrologic Modeling

* HEC-HMS is designed to simulate the hydrologic pi in basins. It includes many hydrologic analysis procedures
such as event infiltration, unit hydrographs and hydrologi ing.
Web: https://www.hec.usace.army.mil/software/hec-hms/

= PRMS is a deterministic, distributed-parameter, physical process based modeling system developed to evaluate the
response of various combinations of climate and land use in streamflow and general watershed hydrology.
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Figure 97 : Slides 8 and 9 of course 8, available via the FuseGl VLE platform.

There is a toolbox available with QGIS that allows hydrological analyses to be carried out. This
toolkit is known as SAGA (Figure 98).
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3. Hydrological Analysis - Toolboxes (1/3) w PR

* Hydrological analysis tools are important resources and are used in a variety of programs to define how the geographic
range of an area interacts with water.

* Itis performed to quantify the volumetric flow rate of water draining from a watershed (e.g. drainage area) over time.

* Hydrological analysis can aid researchers and emergency personnel in identifying the source and pathway of
groundwater, delineating watersheds and identifying communities prone to flooding conditions.

* GIS software includes methods for describing hydrologic characteristics and tools to calculate flow across an elevation
surface, calculate flow path length and assign stream orders.

* These kinds of derived data are often used to aggregate landscape information for input to hydrologic models.

* Hydrological data can help us prepare and plan for extreme events by identifying where the risks are highest and
better manage water resources in ways that suit the economical state and the environmental needs.

* Hydrological analysis is mainly based on a digital elevation model (DEM) raster data to establish a water system model,
which is used to study the hydrological characteristics and simulation of surface during the hydrological process.

FuseGl advancing GIS professional skills 10

3. Hydrological Analysis - Toolboxes (2/3) t:* s

* QGIS has an extensive set of tools available for hydrological analyses located in the hydrology toolbox.

* There are many tools for spatial data processing of hydrological model inputs. These tools are not native QGIS
commands, most of them come from SAGA GIS and GRASS GIS under the processing tool.

* These tools allow you to:
« Perform depresionless elevation layers,
+ Extract stream networks,
* Delimitate basins and channel networks.

* Processing Tab > Toolbox > SAGA.
SAGA (System for Automated Geoscientific Analysis) is a free, hybrid, cross-platform GIS
software which provide many geoscientific methods bundled in so-called module libraries.

= The plugin does not include SAGA itself. To use the plugin you need to install SAGA. Visit the 2
SAGA homepage for installations and packages. :
1 3o

= Tools given in SAGA library can be used as any other processing algorithm: as a standalone
tool, in batch processes, in models and scripts.
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w

. Hydrological Analysis - Toolboxes (3/3) rusest

Erasmus+

* Processing Tab > Toolbox > SAGA.
* Simulation — Hydrology

© TeTEamnce

~ Simulation - Hydrology ~Terrain Analysis - Hydrology
& s

& Diffuse Pollution Risk & Edge Contamination

* Terrain A’mlysis —Channels & Overland Flow & Flow Accumulation (Flow Tracing)
« Terrain Analysis — Hydrology & Overiand Flow (Kinematic Wave) & Flow Accumulation (Paralleiizable)
& Quasi-Dynamic Flow Accumulation & Flow Accumulation (Recursive)
& Surface and Gradient & Flow Accumulation (Top-Down)
* These three libraries of tools can mainly used gx:;; ;:dwmndmmmmn g:::::::ﬁ:;:“
in a hydrological exercise. & Water Retention Capacity & Flow Width and Specific Catchment Ares
& Isochrones Variable Speed
& LakeFlood
* You will also need tools such as clip and extract gtzi«:v s
, actor, Field Base
so to isolate the data of your study area. P & Maximum Flow Path Length

& Channel Network and Drainage Basins.
ver o
& Overland Flow Distance to Channel Network S SAGA Wetness Index

s & Strahler Order
* Add land-cover data or other spatial data @ Vatley Depth g;:i:t:i‘; N

depending on every case. & Vertical Distance to Channel Network
p g ry @ Watershed Basins. g ::‘Tm Powel Index
& Watershed Basins (Extended) o
- x & Topographic Wetness Index (TWI)
* Create 2D maps using the right tools and & Upsiope Ares

symbols.

& Melton Ruggedness Number

* A complete hydrological analysis uses a variety of QGIS toolboxes, not only for data extraction but also their
presentation.
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Figure 98 : Slides 10, 11, and 12 of course 8, available through the FuseGl VLE platform.

The digital elevation model is widely used in environmental science, whether in hydrology or
vegetation cover management. This course allows you to define and create this type of
model (Figure 99).
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4. Digital Elevation Model (DEM) (1/2) \_ﬁ —

* DEMs can be generated using point data sets from elevation data or from aerial imagery using remotely sensed data.

= Often, DEM datasets that are already interpolated can be quite large, so if you are looking to analyze a large area, it
might be best to find elevation point data and interpolate them yourself.

* It is very important to create a working directory where you will keep all your data and progress files. After opening
QGIS, create a new project and save it to your working directory,

* Users can either download Digital Elevation Models from online or create them from the contour layers.
+ Elevation data is abundant, it is just a matter of finding the right one to suit your needs. Check the follow free global
DEM data sources:

. Space Shuttle Radar Topography Mission (SRTM)
. ASTER Global Digital Elevation Model

JAXA's Global ALOS 3d World

. Light Detection and Ranging (LiDAR)

. Mars Orbiter Laser Altimeter (MOLA)

GbwN e
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4. Digital Elevation Model (DEM) (2/2) ﬂ i

+ To create a Digital Elevation Model in QGIS you need a file of height point data or a file of ¢ s of known elevati
You can either find this data online or digitize it on your own. Create a new shapefile of points, in point attribute select
the elevation field. When digitizing the points add the elevation variables.

* QGIS offers two methods of generating TIN, Linear and Clough-Toucher, the second produces smoother surface.

* So, It is possible to generate surfaces of a variable by interpolation, generally using coordinate points with elevation

Information. o i
-~ e
= Load or create the vector file. To access the interpolation tools go to P ing Toolb e
> Interpolation > TIN Interpolati S e T
Metreap Nane Denaty Litimaton)
OW etepieton
* On the extension tab click on the corner button > Use Canvos Layer Extension. Set the
" o
pixel size and define the output files.
* Q2 Raster tewan sralyss
= For further analysis of your DEMs use the Raster Terrain Analysis Plugin. This plugin can be - :m
used to calculate the slope, aspect, hillshade, ruggedness index and relief of digital elevation B Hyprometric curves
models. Processing Toolbox > Raster Terrain Analysis. # rewet
U Roggednen ndex
9 Sepe
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Figure 99 : Slides 13 and 14 of course 8, available via the FuseGl VLE platform.

In addition, the digital elevation model allows the creation of rainwater and surface water
flow direction (Figure 100).

5. Flow Direction — Catchment Area (1/3) :.:* :
rasmus+

* In order to start your analysis, you should have created the elevation model of your study area following the steps in
the previous section.

How can you
understand the right
flow direction?

« Actually, water flows downhill in any direction, because it
always wants to get to the lowest level as quickly as possible
due to the gravitational pull.

* Rivers flow in one direction all over the world, and that
direction is downhill.

* As a rule of thumb, the V-shaped contour is pointing
upstream (the opposite direction from the flow of a stream
or river). The “V” shape contours indicate streams and
drainage.

Georeference the contour map,

Digitize the hydrography network following streams’ flow,
Create the Digital Elevation Model,

Look for mistakes.

ol bina et 2
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Figure 100 : Slide 15 of course 8, available through the FuseGl VLE platform.
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Then, it is possible to determine the watershed in different areas (Figure 101).

and consists of water runoff into surrounding rivers, streams and lakes.

algorithm differentiating where a given pixel would go depending on elevation and cell height values.

« Elevation > Insert DEM data layer

* Method > Choose one model to apply to the DEM data layer
There are five methods to choose from when delineating a
catchment area from a DEM.

[0] Deterministic 8 (D8)

[1] Rho 8

[2] Braunschweiger Reliefmodell
[3] Deterministic Infinity

[4] Multiple Flow Direction

[S] Multiple Triangular Direction
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5. Flow Direction — Catchment Area (2/3) Tﬁ "
5 rasmus+

* A catchment area is otherwise considered a drainage basin. The basin is where water flows over topographic terrain

* Flow direction is the main direction of water run-off over the geographic area of interest. Flow is determined with the

Figure 101 : Slide 16 of course 8, available through the FuseGl VLE platform.

And finally, it is possible to perform additional analyses, such as determining the importance

of the different watercourses in the watershed using the SAGA tool (Figure 102).

* The following steps must be completed in order to calculate the flow direction:

« Calculate Strahler order and determine threshold for streams. SAGA > Terrain
Analysis — Channels > Strahler order. The higher the order, the bigger the stream.
Make a nice legend, where the highest Strahler orders are more blue so you can
clearer see what the rivers are.

« Calculate flow direction, channel network and catchments. SAGA > Terrain
Analysis — Channels > Channel Network and drainage basins.

« Define outflow point, where the water join another water body, such as a river,
lake, sea or ocean.

* Delineate catchment. SAGA > Terrain Analysis — Hydrology > Upslope Area.
Remove all unnecessary layers and clip all the data outside the study area. Create
a .pdf map.
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5. Flow Direction — Catchment Area (3/3) \..\..:* . .
rasmus
»
. spikes

Figure 102 : Slide 17 of course 8, available through the FuseGl VLE platform.

3.9 Course 9: Web Scraping Applications in QGIS

The ninth and final course of the platform is specific to learning "web scraping", i.e. searching
for information online and processing this information with online tools or with software
such as QGIS. This course consists of the introduction of the notion of "web scraping" then
the method of searching for online data, the presentation of a realistic case study in the field

of health, and finally the method of using "web scraping" and QGIS (Figure 103).
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1. Web Scraping Definition
2. Export Data from the Web
3. A Realistic Application of Web Scraping - Health

4. Combining Web Scraping & QGIS
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Figure 103 : Course outline 9, available via the FuseGl VLE platform.

First, web scraping involves importing online data into spreadsheets such as Excel (Figure

104).

Webscrapping of various data sources...

What does Webscrapping mean?
o ) WiKIPEDIA Import data from a website to a spreadsheet table.
« ' Lencyclopédie libre

Excel & Chrome browser offer tools to import tables
from wikipedia/website into an « Excel » spreadsheet.
The easiest is the Excel « Data » dongle
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1. Web Scraping Definition - Clean Data sources (1/2) —::# —

Figure 104 : Slide 6 of course 9, available through the FuseGl VLE platform.

The process is simple to execute, just follow the instructions available in the course (Figure

104).
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1. Web Scraping Definition - Clean Data sources (2/2)

1. Webscrapping of heterogenous data sources in Excel, from a .url web address

2. Webscrapping from Chrome web browser ( Add-in, not used in this case study)

Fichier  Accusl  Inseion  Miseenpage  Formules
71 A partir d'un fichier texte/CSV 7 Sources récente?
2 Conneionsexitntes
Obten
données -

© nrory

!
2 |Anderleq
3 |Brussel /|
4 |Elsene /|
5 |Etterbeek L
6 Evere 43
7 |Ganshoren 25
8 Jette 52
o |¥navainar ”
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Figure 105 : Slide 7 of course 9, available via the FuseGl VLE platform.

The export of this data is a rather simple process but can cause some problems, some

solutions of which are given in the course (Figure 106).

2. Export Data from the Web (1/2)

Web Scraping and improving the quality of the data:

Typical Web Scraping problems and cleaning solutions g0 ::::::mm.w o D s et
Obtenir des _‘:Amnd 5|

provos

0 rommowssn 3 2 ot
o

Names mismatching Wrong Numbers/ Characters

jcommunes ____________________H colonne1.2.1 B colonne1.3 B rusionné K 2 [} tatewe manct
= L femer et Actusise Girees
Anderlecht 121 396 1213 AL 2 chae Gére ~ <olonnes
Brussel / Bruxelles 187 686 187686 Femes Reaute
Elsene / Ixelles 86 o7 a7 5 N .
Etterbeek a8 23 48223 T Aaderiect '
Evere L] 481 43481 3 Brussel/Bruselles | §
Ganshoren > 202 25202 4 Eisene/ ixelies
Jette 2 04 52604 5 etterbeek
Koekelberg 2 997 21997 6 lEvere
Oudergem / Auderghem u 537 s PowerQuery  ; gansnoren
Schaarbeek / Schaerbeek 130 7 13021 — 8 Jette
& / Ag > 288 25288 9 Koekelberg
Sint-Gillis / Saint-Gilles 48 498 48498 10 Oudergem / Audergt
Sint-Jans-Molenbeek / Molenbeek-Saint-Jean 97 02 sno 11 Schaarbeek / Schaert
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Figure 106 : Slide 8 of course 9, available via the FuseGl VLE platform.

When extracting data, the use of a table such as Excel is essential (Figure 107).
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2. Export Data from the Web (2/2)

Web Scraping: Cleaning the data with Excel PowerQuery
Reference : Online PowerQuery course (Microsoft)
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Figure 107 : Slide 9 of course 9, available via the FuseGl VLE platform.

A case study on web scraping is available to practice its use. This course introduces this case
study (Figure 108).

3. A Realistic Application of Web Scraping — Health (1/ 7) —\..'.* —

What happened in Brussels during pandemic...

1. Brussels region context : the epidemic keeps spreading in Brussels region, due to lack of

vaccination in some part of the city. The Minister has to solve this by creating a targeted

local vaccination campaign in some area (street vaccination). 2 scope.

2. How to understand and geolocalize areas with a too small proportion of vaccinated
people ?

3. Webscrapping of heterogenous data sources. Matching them with the Minister
confidential data

4. Graphic correlations with ages, revenues, neighboorhod...
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Figure 108 : Slide 10 of course 9, available through the FuseGl VLE platform.

It is important to use a . Json to delimit the contours of municipalities (Figure 109).
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3. A Realistic Application of Web Scraping — Health (2/7) W S

From country = to localities.
You need a *.Json file with the borders of Municipalities. Restrict it to Brussels region municipalities

Les communes en vert ont atteint les 90%
de personnes partiellement vaccinées

Json subfiles for the targeted municipalities
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Figure 109 : Slide 11 of course 9, available through the FuseGl VLE platform.

The general steps of the case study as well as the purpose of the case study are detailed in
this course. The case study includes more specific and simple steps to follow (Figure 110).

3. A Realistic Application of Web Scraping — Health (3/7) \-::* —

1. Sources : Json / Minister / website national institute of statistics

2. Goals: simple GIS tasks with tools simplier than Qgis/ArcGis
3. Easy GIS visualization tool : Datawrapper/(Floorish)

4. Webscrapping of heterogenous data sources

5. GIS mapping From country to neighborhood level

6. Correlations with ages, revenues, neighboorhod
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Figure 110 : Slide 12 of course 9, available via the FuseGl VLE platform.

In the example of the course, the cartographic representation is created using the online tool
"Data wrapper", not with the QGIS software (Figure 111).
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3. A Realistic Application of Web Scraping — Health (4/ 7) w S

1) Select the map. = 2) Copy-paste the cleaned data. = 3) Choose the column to visualize

Datawrapper o Dashboard

Revenu imposable médian des déclarations

Sélectionnez votre carte v 2 Aoutez vos données Visualisez v

1 Premiére ligne en éiquettes

Now your map needs data!

e table with Nom (néert) keys.
1t adding your vahues of upload your own file

Match eck v
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Figure 111 : Slide 13 of course 9, available via the FuseGl VLE platform.

The data is also sorted through the use of a table such as Excel or LibreOffice (Figure 112).

3. A Realistic Application of Web Scraping — Health (5/7) \..:;* —

» Cleaning of dirty data sources with Excel/LibreOffice

a

© ot de saoeé por proey
© Soins groupas cibles
© Consemmation de médicaments

» Antibiotiques {ambulsolre) ( f N

rfeeqon OBH

-}
«
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Figure 112 : Slide 14 of course 9, available via the FuseGl VLE platform.

These data are actual data of the vaccinated or unvaccinated population in the region and
municipality of Brussels (Figure 113).
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The region and the municipalities of Brussels
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3. A Realistic Application of Web Scraping — Health (7/7)
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3. A Realistic Application of Web Scraping — Health (6/7) \..\.:a ——

oo

Figure 113 : Slides 15 and 16 of course 9, available via the FuseGl VLE platform.

When using this data in QGIS, it is possible to add vector files from the region. These files

provide details on the data according to the location of the data (Figure 114).
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4. Combing Web Scraping and QGIS (1/4) @ Exe

Add the vector file of the region..
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Figure 114 : Slide 17 of course 9, available via the FuseGl VLE platform.

It is also possible to correlate average incomes with the percentage of vaccination or to
correlate the average ages of populations with vaccination rates in the region and municipality
of Brussels (Figure 115).
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» Correlations : revenues and vaccination rate

Vaccination percentage
Median revenue
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4. Combing Web Scraping and QGIS (3/4)

» Correlations : ages and vaccination rate
Vaccination percentage

~ | &’

Part des 65-79 ans dans la population totale 2019 (%) k
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4. Combing Web Scraping and QGIS (2/4) @ —

Figure 115 : Slides 18 and 19 of course 9, available via the FuseGl VLE platform.

Then, it is possible to make assumptions about the observed correlations (Figure 116).

[vaccination rate : Mars 2022 ]
 — South-West areas are
L populated with richer and

vaccinated in 2021.

Consequently, in march [EEIEEED
&

2022 their margin of
ar
=
E

progression is small for
increasing vaccination

jounger populated
North-East areas show a
hig vaccination rate in
March 2022, because
many young people |2
where not vaccinated yet I 2m
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4. Combing Web Scraping and QGIS (4/4) .\..:* I

Revenu imposable médian des déclarations :

(6] Fev caou]

Solution and paradoxal observations ?

20

Figure 116 : Slide 20 of course 9, available via the FuseGl VLE platform.
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Finally, this course concludes with practical observations concerning the use of web scraping
and QGIS (Figure 117).

4. Combing Web Scraping and QGIS (4/5) -«m$) —

» Practical observations

Iu

1. Simple online and “excel” type tools are enough to give students good data and mapping
analyses.

2. QGIS is the main tool that can visualize the data and create useful maps. It is very

important to extract clear data from the Web but in order to be used they need GIS.
3. Health and revenues have a strong visual correlation on the map.
4. QGIS can be used in a variety of applications in Health. Visualizing pandemic results,
vaccination, health problems, etc.

5. Different kind of data can be extracted through Web Scraping
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Figure 117 : Slide 21 of course 9, available via the FuseGl VLE platform.

4 The case studies

The case studies aim to put into practice the theoretical knowledge acquired through the
courses. The four available case studies are linked to the three areas applied throughout the
project, i.e. forestry, health and hydrology. Of these four case studies, one focuses on forest,
one on health and the last two are oriented towards the field of hydrology. Despite the
different areas of the case studies, each brings essential knowledge to fully use GIS.

4.1 LULC/FOREST case study

This first case study is intended to take ownership of LULC, i.e. land use and land cover for a
defined area. The area studied is the island of Chios located in Greece. LULC is a dynamic
feature that is useful to track relevant changes in land cover. This case study is created to test
the skills acquired during the courses, aiming to map forest changes in Chios in three areas of
different altitudes. The main questions are: How has forest changed the last 10 years in Chios.
Is there gain or loss of forest and is this gain/loss dependent to elevation? The instruction
for this exercise is given in the form of a succession of steps to follow (Figure 118). This
sequence of steps is intended to answer a specific question (Figure 119).
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Figure 118 : sequence of steps to complete the LULC exercise, available on the FuseGl VLE platform.

Basic guestion

How has forest changed the last 10 years in Chios? Is there gain or loss of forest and is this gain/loss dependent to elevation?

Figure 119 : Final question of the exercise, available on the FuseGl platform.

This exercise can be done in about 8 hours for people who are new to the field of GIS and are
not familiar with using QGIS software.

As a first step, it is important to upload all the data available on the platform in the "provided
material" space. Then simply launch the QGIS software and start the exercise. First, add the
polygon downloaded from the island of Chios, then add the LULC (Figure 120).
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Figure 120 : Overview of the "Chios polygon" layers and LULC in the QGIS software.

It is possible to cut the LULC directly to the shape of the polygon or to do it in the next step.
In this example, we have chosen to categorize LULC into different classes. All you have to do
is change the symbology of the LULC layer using the "categorized" symbol type and selecting
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the value with which we want to categorize the polygon. Next, change the style and select a
style downloaded with the data for the exercise (Figure 121).
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Figure 121 : Overview of the path to change the style of LULC.

We then obtain the map of Europe of several colors corresponding to different types of land

cover (Figure 122).
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Figure 122 - The result of changing the style of the LULC layer.

To make loading in QGIS faster, it is important to cut the studied area with the "Cut" tool

(Figure 123).
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Figure 123 : Using the "cut" tool.

We then obtain the following result (Figure 124):

(@ *Projet sans tive — QGIS 5
Projet fditer Vue Couche Préferences Fxtensions Vecteur Raster Hasededonnées intemet Mailage MMKGIS Iraitement Aide
BRRE QNP o e Lo oF =4 L~
aQV.2e B / =q 8= Qqee - B »
E-2-5-5% @ - B
Fxplorateur ox
.eYmo
Marque-pages =
» 1 Signets spatiaux
> 1) Accueil
» D
@ GeoPackage
/£ spatialite
@ rostiis
SsQL
@ Oracle.
& 002
» @ WMSWMTS
f Vector Tiles
» 7 Ties
& wes =
Couches o2
LesTY 410
= ¥ (7 Découpé &
v Il 11170 Continuous urben fabric (IMD =>80%)
v Ml 11120 Dense urban fabric (MD =>30-80%]
! Bl 11130 Low density fabric (IMD <30%)
10 Industrial, commerdial, public and military units (o
1220 Nuclear energy plants and associated land
v Il 12100 Road networks and assodsted land
'l 12200 Railways and assoclated land
V. 12310 Cargo port
Vi1 12320 Passenger port -
oK Coordonnde 5656616,1815332 B Echelie 1:6268178 ~  fgb Loupe 100% 3 Rotson 00° 3| v Rendu @epecauss @

Figure 124 : Result of cutting the LULC layer.

Next, it is requested to add Google Earth in order to visualize the vegetation differences

between the LULC and the aerial view (Figure 125).
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Figure 125 : LULC layer superimposed with the aerial view of Google Earth.
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The next step is to add a DEM layer. DEM layers are raster-like layers presented with the "tif"
extension (Figure 126).

&
* Type de source
Bz ¢ © Fickier  Protocoie: HTTP(S), coud, efc.
»
LL A
Jeusx de. c dem_chios 6 a
3 w0
Explorateur QX Ouvrir des jeus de donnees raster géres par GDAL

eYte
s StudyCase Forest > DEM ) ¥

4 Signets spatisux

» [™ Dossier du projet Organiser + Nowweau dossier

» (6 Accuell
o

@ i @ OneDrive - Person Noai
‘ackoge

/£ spatialite wcepe [l Digital Elevation Madel (DEM) 20220525
PostGIS ou dom chios thw

: MSSQL I Burea

= v dem_chios
I Dosnitaity eu_ e chios i e
= Images

D Musique

3 Obets 20

& Téléchargements
B videos
0503

au_dem_chios.tilove

o Réscsu v ¢

Norm du fichier : eu dom chios Tous les fichiers

3 Viked Bwean @

Coordonnde 5712659,1874513 B Cchade 1421096~

Figure 126 : The path to add the DEM raster layer.

We then obtain a raster type layer of the different altitudes on the island of Chios. It is
possible to modify the style by categorizing it with the different altitude levels, but this step

is not mandatory (Figure 127).
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Figure 127 : Categorization of the different altitude levels.

Next, the raster must be reclassified using the "reclassify by table" tool. This step will assign
a new value based on the ranges specified in a fixed table (Figure 128).
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Figure 128 : Preview of the table to modify using the "reclassification by table" tool.
We then get a map with only three different elevation zones (Figure 129).
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Figure 129 : Result obtained by reclassifying the raster layer to DEM.

Then, it is asked to polygonize the DEM raster into a vector using the "polygonize" tool. This
tool creates a polygon with an attribute indicating the pixel value of the polygon (Figure 130).
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Figure 130 : The path to follow in order to polygonize the raster layer into a raster layer.
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It is therefore possible to merge the layers of the vectorized DEM and those of the LULC using
the "intersection" tool (Figure 131).
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Figure 131 : Path to follow in order to use the "intersection" tool.

The result obtained then corresponds to the two merged layers, in color the LULC and the
black lines the limits of the three different altitudes of the DEM (Figure 132).
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Figure 132 : The result of using the "intersection" tool merging the LULC layer and the boundaries of the DEM
altitude zones.

Finally, the final step is the creation of a map representing changes in vegetation cover,
whether it is a gain in forest or a reduction in forest (Figure 133).
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Figure 133 : Creation of the cartographic representation representing changes in vegetation cover as a function of
altitude.

Finally, it is possible following this practical case to determine what are the changes in
vegetation cover in the three different altitude zones. In the area closest to the sea,
vegetation cover has increased, while in the highest area at higher altitudes it has
decreased. On the other hand, it remains unchanged in the average altitude zone.

4.2 Health Case Study

This second case study is intended for online data search and the use of online tools. The
sector studied is the European city of Brussels in Belgium. This case study is created to test
the skills learned during the courses, aiming to determine the rate of people vaccinated in
each neighborhood of the city. The goal is to make a preliminary study of vaccinations in order
to plan a new vaccination campaign (Figure 134).

Where and in which range of ages should the vaccination campaign be focused ?

What you have learned for matching Covid vaccination data and GIS visualization of webscrapped datasets ?

Figure 134 : Health Case Study Objectives, available on the FuseGl platform.

As with the first case study, the steps to follow are available on the FuseGl platform (Figure
135).
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1. Find the .*Json map file with municipalities borders
v Course 4 (hint — import data)

2. Web Scraping of population data (from wikipedia or Ministery website)
v Course 9 (hint — Web Scraping)

3. Cleaning the dataset (Exel, PowerQuery) & matching the 2 datasets (population, vaccination, revenues)
v Course 9 (hint — clean data)

4. Insert excel data to an attribute table

v Course 2, 4 (hint — attribute table)

v Course 2, 4 (hint — statistics, attribute table)
6.  Create map using the right scale of colours

v Course 6 (hint - map layout)

7.  Observe, explain and finally publish your results online :

5. Create a simple calculation between the 2 data sets : Vaccination rate = (vaccinated people)/(municipality population)

Figure 135 : Steps to complete the health case study.

After downloading the data available on the FuseGl platform, we must add the polygon layer
representing the city of Brussels and the different districts on QGIS (Figure 136).
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Figure 136 : Preview of the "polygon" layer added in the QGIS software.

Then, after finding the necessary data on the internet, it is possible to load this data on a

spreadsheet, such as Excel, by adding the data "from the web" (Figure 137).
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Figure 137 : Overview of loading data "from the web" into an Excel spreadsheet.

The data can thenbe exported to QGIS, or can be used with on-line processing tools (Figure
138).
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Figure 138 : Data processing using QGIS software.

Finally, the last step is the creation of the cartographic representation of the vaccination rate
by neighbourhood in Brussels (Figure 139).
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Q

Figure 139 : Creation of the graphical representation of the vaccination rates of the inhabitants of Brussels using
the QGIS software.

After making such a map, whether using QGIS or online tools, it is then possible to determine
in which neighborhood it is important to carry out a new vaccination campaign.

4.3 Case Study 1 in Hydrology

This third case study is intended to use useful tools in the case of a hydrological study. In this
exercise, users of the platform will have to assess the alteration of the coastline of a lake in
Greece, which affects the residential areas and land use around it.

This case study is created to test the skills acquired during the courses, aiming to map changes
in water bodies and alterations in lake hydromorphology (Figure 140).

Basic question

How were the lake and its rivers modified in a 45-year period affecting the
coastal area?

Figure 140 : Objective of the hydrology case study n°1, available on the platform.

The instruction for this exercise is given in the form of a succession of steps to follow (Figure
141).
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Georeference both images

Course 4 (hint - georeference)

Digitize coastline

Course 4 (hint — polygon)

Create a buffer zone of 200m starting from the coastline towards the inland area (coastal habitat zone) for both years
Course 5 (hint — geoprocessing)

Calculate difference in lake perimeter (m), lake area (m2), and buffer area (m2) among years
Course 2, 4 (hint — attribute table)

Find what kind of Land Uses (CLC Ivi2) substituted the area that used to be covered by water
Course 5 (hint - spatial analysis)

Place images on DEM

Course 8 (hint — SAGA > Terrain Analysis) or Course 7 using GRASS

Deploy Hydrographic network using the DEM

Course 8 (hint — SAGA > Hydrology > Channels)

Calculate Strahler order
Course 8 (hint - SAGA > Hydrology > Calculate Strahler Order)

Define lake catchment area and all sub-basins

v Course 8 (hint — Catchment area) or Course 7 using GRASS

Create a map pointing out the differences in LULC of the coastal habitats (buffer) with fully deployed hydrographic network

Course 6 (hint - map layout)

Figure 141 : List of steps to complete the case study, available through the FuseGl VLE platform.

After downloading the two aerial photographs of the lake dating from 1969 and 2016, you
must launch the QGIS software to georeference the photographs (Figure 142).
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Figure 142 : Georeferencing of an aerial photograph, with QGIS software.

Georeferencing makes it possible to obtain aerial photographs of the lake at exactly the same
location as the lake observed with Google Satellite (Figure 143).
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Figure 143 : Georeferencing result of aerial photography.

Then, we must digitize the shores of the lake by adding a new Shapefile layer (Figure 144).
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Figure 144 : Definition of the shores of the lake by creating a shapefile.

It is then possible to use the "buffer" tool to create a 200-metre buffer zone from the lake
shore (Figure 145).
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Figure 145 : The result of using the "buffer zone" tool.
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Using the attribute table and the field calculator tool, it is possible to calculate the lake
perimeter, lake area and buffer zone area (Figure 146).
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Figure 146 : Calculations of the perimeter and area of the lake, using QGIS software.

By spatially analyzing the area, it is possible to find out how the land around the lake is used
over the years. Then the DEM can be added. To facilitate its use, use the "cut" tool to obtain
the DEM for the lake area only and avoid excessive loading times (Figure 147).
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Figure 147 : Added the trimmed DEM layer in the QGIS project.

With the help of the DEM layer, it is then possible to start the more in-depth hydrological
analysis, such as highlighting the hydraulic network in the area studied (Figure 148).
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Figure 148 : Use of the tool "SAGA - channel network" to highlight the hydraulic network of the sector studied.

The hydrological study continues with the use of the SAGA tool "Strahler Order" (Figure
149).
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Figure 149 : Result obtained after using the "SAGA - Strahler Order" tool in the QGIS software.

And finally, we want to define the watershed of the lake as well as the sub-basins. Forthis, it
is necessary to use a last SAGA tool available in QGIS, the tool "catchment area" (Figure
150).
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Figure 150 : Using the "SAGA - catchment area" tool in the QGIS software.

At the end of this analysis, it is possible to create a cartographic representation of the area
studied (Figure 151).

Différents types de terres utilisés (LULC) dans la zone tampon et
réseau hydrographique autour d’un lac en Gréce

Figure 151 : Cartographic representation of the different types of land used (LULC) in the buffer zone and the river
network around the lake in Greece.

4.4 Case Study 2 in Hydrology

This last case study is intended for the handling of the attribute table. In this exercise, users
of the platform will have to prioritize rivers according to their sensitivity, using several criteria
in the perspective of climate change, in the PACA region in France. To do this, you will first
have to download the data from the "provided material" section on the FuseGl platform. The
steps to complete this case study are also available on the platform (Figure 152) (Figure 153).
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At the end of this work, we should be able to assess a degree of sensitivity (from low to high) to each section of rivers (WFD Surface Water Body), based on information
provided by several existing databases, and better direct the program of measurements

1. Seleet the water bodies whose linear is entirely within the scope of the PACA region

Use the MDORiviere and Région_PACA table:

2. Select appropriate column from existing databases or spreadsheet to meet chosen criteria

We want to cross the pressures related to the low water level of a river with the altitude of the catchment area, which are two contributory factors to strong thermal variations.
The statistical processing of the monitoning data shows that the temperature range (vanability) mostly charactenzes the mid-mountain sectors and, to a lesser extent, the high
mountain termitories.

3. Assign degrees for each assessment (3 numerical levels)

Field Evaluation Coding
Low water low water Low 1
pressure lavels Medium 2
High 3
Field Evaluation Coding
Altitude of Water | Alt_cat Low 1
Body HIGH 2
MID 3

Figure 152 : List of first steps in this Hydrology 2 case study, based on the FuseGi platform.

4. A cross-checking must be camied out with these wo criteria in order 1o get three levels (low = 1, medium = 2, high = 3) in a new column and a new row (variations being
amplified by low water level of the river and low water renewal)

Altitude of Water Body

1 2 3
1 Low Low Medium
Low water pressure 2 Low | Medium |  High
3 Medium High High

5. The other criteria are added to the result obtained by crossing, to have a total maximum scare of 10 at the end.
Fields Crileria Coding
Influence of | Geol_cat C 0
groundweler CE_exogene if CE_exogeneand S | 0
S +1
Evaluation Coding
Pressures on Low influence +1
hydromorphology Madium influence +2
High influence +3
Evaluation Coding
Pressures on riverine | Low influence +1
1
sysiem Medium influence +2
High influence +3

6. Categonize the total score (number of classes and interval of your choice) to get a spatial representation of the target area.

Figure 153 : List of final steps in this Hydrology 2 case study, based on the FuseGi platform.

After opening the QGIS software and adding the region layer as well as the MDORiviere layer,
it is possible to cut the MDORIiviere layer in order to keep only the part concerned by our case
study, i.e. the part of the PACA Region. You must then add the downloaded table by following
the following path "layer", then "add a layer", then "add a spreadsheet layer". Then, in order
to facilitate the processing of data between the table and the cut MDORIiviere layer , it is
necessary to go to the parameters of the latter and create a join between the two layers
(Figure 154).
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Figure 154 : Steps to join the table and the MDORiviere layer in the QGIS software.

Once the join is done, when we open the attribute table, we find both the attributes of the

MDORiviere layer cut and those of the table (Figure 155).
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Figure 155 : Preview the attribute table after joining the two layers.

It is then possible to perform all the steps of data classification thanks to the attached
attribute table and to obtain the most sensitive rivers in the face of climate change (in red)

and those least sensitive (in white) (Figure 156).
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Figure 156 : Result after classification of data, in red the most sensitive rivers and in white the rivers least
sensitive to climate change.
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5 Innovation, Tangibility and Transferability

104 training toolkit assists end users to deal with geospatial data and their transformation into
trustworthy and actionable information; through Geolnformatics (Gl), which include a number
of different technologies, processes, and methods that allow the effective acquisition,
processing and analysis of accurate and up-to-date geospatial data. Concerning Quality
indicators measurement, 9 training videos and an equal number of guides were developed to
assist new GIS users to get familiar with commands processes and applications’ usefulness
and to also work as a guide for more GIS-experienced users. Two different types of modules
(teaching and/ or training) are supported and more are considered (with modifications) giving
the possibility for the toolkit to be included even in life-long learning courses.

Innovation

The teaching material produced contains several novel and innovative elements, which can
be found from the design phase up to the teaching phase, as:

e All materials in the toolkit are novel, free of rights and created within the consortium.

e It assists the enhancement of competencies of professionals supporting digital
education.

e It bridges academic and professional needs in different key environmental and health
sectors.

e |t covers simultaneously market skills gaps and educational/cognitive ones.

e |t supports distance training novelties: different forms of communication and learning
(Hybrid supported besides asynchronous through chats), two-way evaluation process,
self-assessment, supplementary data provisioning, without fixed time courses but of
relative duration

e It endorses different teaching methods: connection making, increased autonomy, no
limits hands on practice.

Tangibility

A lot of effort was put, in order to create tangible results, since design phase of the teaching
material, as:

e Has homogenous but yet flexible structure for each course within the VLE.

e Offers ability for adaptation and evolvement, i.e., adaptive international curriculum
(from postgraduate to continuing education for engineers) targeting skills acquired in
GIS.

e Adopts no discrimination policy with provision for inclusive and equitable online
learning environment

Transferability

The main concept was to develop a tool that could easily be transferred and either adopted
as it is or evolved, depending on the users' needs. Having this in mind the two major aspects
were covered:
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The toolkit supports openness in all stages: the entire tool is based on freeware (QGIS)
supporting openness in its entity using explicitly creative commons rights, open data,
open courses and free books and manuals in the PowerPoints and in the
supplementary material and operating through an open VLE platform. This also
enhances the innovative character of the produced toolkit.

This 10 includes a detailed methodological approach, with rational explanation, which
is easily transferable to other developers.
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